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Overview

Introduction

This guide provides information and instructions for maintaining the current 
functions of a CallPilot server, and for troubleshooting any problems that m
arise.

Who should read this guide

This guide is for planners, administrators, technicians, and engineers respon
for maintaining a CallPilot server. It is intended to act as a guide for installin
repairing, replacing, and upgrading hardware and software components. It 
assumes that the reader has basic computing skills, is familiar with necessa
safety procedures, and has the hardware documentation provided by the 
manufacturer available as a reference.

Assumptions

This guide assumes that you are planning to maintain or troubleshoot an ex
CallPilot server.

Glossary and related documents

Part 1 of this binder contains a glossary and a list of related documents.
12 CallPilot
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Skills you need

Purpose

This section describes the skills and knowledge you need to use this guide 
effectively.

Nortel Networks product knowledge

Knowledge of, or experience with, the following Nortel Networks products is
helpful when administering the CallPilot server:

� 200i Server

� 702t Server

� 1001rp Server

PC experience or knowledge

Knowledge of, or experience with, the following PC products is helpful when
administering the CallPilot server:

� Microsoft Windows 95 or Windows NT

� client/server architecture

� Internet Protocol (IP)

Other experience or knowledge

Other types of experience or knowledge that might be useful include the 
following:

� database management

� programming
Part 5: 200i Server Maintenance and Diagnostics 13
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Symbols and conventions

Symbols

You might encounter the following symbols in this manual.

Danger

Warning

Caution

Note: Describes the secondary results of procedures or commands, or spec
conditions under which a procedure or command must be used.

. 

Risk of electric shock
Warns you of an immediate electrical hazard which, if not
avoided, will result in shock, serious injury, or death.

. 

Risk of personal injury
Warns you of a situation in which you can be injured if 
instructions are not followed exactly as stated.

. 

Risk of equipment damage
Alerts you to situations where data can be lost or damage
equipment can be damaged, actions can result in service
interruption, and productive time can be lost.

ATTENTION Provides information essential to the completion of a task
14 CallPilot
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Choosing commands for procedures

For many procedures in this guide, there are several different ways you can
perform the same task. For example, to copy text, you could choose any of
following methods:

� Choose Copy from the Edit menu.

� Click Copy on the toolbar.

� Type the keyboard shortcut Control+C.

This guide uses the first method.
Part 5: 200i Server Maintenance and Diagnostics 15
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Preparing for maintenance activities

Introduction

Maintenance activities are tasks you perform to ensure the proper functionin
your server or to fix any problems that occur. Before you begin any maintena
activities, collect all the tools you need, and follow all recommended safety 
precautions.

The remainder of this chapter discusses required tools for maintenance 
activities, as well as recommended safety precautions for electrostatic disch
handling cards, and handling your server.
16 CallPilot
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Required tools and safety precautions

Introduction

If you need to replace or upgrade any system parts, follow Nortel Networks t
and safety guidelines to prevent personal injury and damage to the server o
replacement parts.

Maintenance tools and materials checklist

Use this checklist for the tools and materials you might need to perform 
maintenance and diagnostics tasks. 

. 

WARNING

Risk of personal injury and equipment damage
Field maintenance must always be performed by fully 
qualified, trained personnel.

Check Description

Phillips cross-head screwdriver 

Standard slot-head screwdriver (1/4" and 1/2")

Sidecutters

Jumper removal tool or needle nose pliers

Tape measure for determining cable lengths

Tweezers

Antistatic ESD wrist strap (recommended)

Pen or pencil for writing notes, cable lengths, and cable 
identifications

Cable tie wraps

Pen or pencil for noting cable lengths and labeling cables
Part 5: 200i Server Maintenance and Diagnostics 17
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Approved replacement parts

Before replacing any parts on your server, contact your Nortel Networks 
customer technical support organization for a list of approved add-in boards
peripheral devices. The use of non-approved replacement parts can cause s
system problems or void your Nortel Networks warranty.

General safety

Nortel Networks recommends that you observe these safety guidelines as y
work on your server:

� Plug the peripheral devices into properly grounded power sources to 
prevent electric shock.

� Ensure that nothing rests on your server’s cables and that you cannot t
over or step on the cables. 

� Do not spill food or liquid in the server.

� Do not push any objects into the openings of your server.

Cooling and airflow

For proper cooling and airflow, always install the chassis top cover before 
turning on the system. You risk damaging system parts if you operate the sy
without the cover in place.

Cable identification labels

Equipment log. This is used to record the model and serial
number of the system, all installed options, and other 
information.

Check Description
18 CallPilot
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Avoiding electrostatic discharge

Introduction

Electrostatic discharge (ESD) can seriously damage component parts such
disk drives, boards, and other parts. Nortel Networks recommends that you
perform the maintenance procedures described in this section at an ESD 
workstation.

Antistatic wrist strap

If an ESD workstation is not available, provide some ESD protection by wea
an antistatic wrist strap. Ground the ESD wrist strap by attaching it to any 
unpainted surface on your system chassis.

While you work

As you work inside the server, periodically touch an unpainted surface to 
discharge any static your body might have accumulated.

Conductive foam padded in-boards

After removing a card from its protective wrapper or from the system, place
component-side up on a conductive foam pad. If possible, use antistatic flo
pads and workbench pads.
Part 5: 200i Server Maintenance and Diagnostics 19
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Handling cards

Introduction

Electronic components are sensitive to the environment and to electrostatic
discharge. To protect equipment and prolong the useful life of components,
Nortel Networks recommends that you follow the precautions described bel

Avoiding electrostatic discharge

Electrostatic discharge (ESD) affects the performance and decreases the u
life of system components. Use caution when handling cards or server 
components to prevent damage. Wear an ESD wrist strap when handling sy
parts.

Precautions for handling cards

Take these precautions with any procedure that includes an add-in board:

� After removing a board from its protective wrapper, or from the server, 
place it component-side up on a grounded, static-free surface.

� Do not slide a board over any surface.

� Do not touch board components or gold-edge connectors on the board

� Hold a board by the top edge, or by the side edges.
20 CallPilot
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Handling hard disks

Introduction

Hard disks are extremely sensitive to vibration and physical shock. To prote
equipment and prolong the useful life of hard drives, Nortel Networks 
recommends the following precautions.

Avoid vibration or physical shock

Hard disks are susceptible to even slight vibrations. A hard disk can be dam
if it is placed on a table that is accidently knocked or moved. Use caution w
handling hard disks to prevent damage.

Precautions for handling hard disks

After removing a hard disk from its protective wrapper, or from the server, pl
it on an antistatic, padded workbench or workstation to avoid movement or 
jarring.

Shipping damage

If your hard disk is shipped independently for either an upgrade or a 
replacement, note any dents or damage on the padded container and pack
Keep the container to prove that the part was damaged during shipping and
handling.

Precautions when removing hard drives

Perform a proper system shutdown, and then remove the drive. See Chapter 5, 
“Hardware maintenance and upgrade,” for instructions.
Part 5: 200i Server Maintenance and Diagnostics 21
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Store hard drives

If you purchase extra hard disks, store these hard disks in the original padd
container. Store the disks away from places where they might be moved or
jarred.
22 CallPilot
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Status LED and hex display location

The following picture shows where the status LED and LED hex display are
located on the 200i server faceplate:

Status LED

LED hex display 
(four characters)
26 CallPilot
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Understanding the Status LED

Introduction

The LED is located on the faceplate of the 200i server, immediately under t
SVGA connector.

The server’s LED is controlled exclusively by the server. The LED does not 
respond to any input commands from the switch console.

LED functions

The LED indicates two server states:

� the completion of self-test diagnostics

� when it is safe to remove the server from the switch 

Server boot sequence indicators

When the server is inserted into an IPE shelf, the following sequence of LE
indicator status occurs:

Activity LED status

The 200i server is not locked into the IPE shelf. Unlit

The 200i server is inserted into the switch and 
receives power.

Lights

Self-diagnostics completes with no critical errors. Blinks three times

Boot sequence starts, ending after Windows NT 
successfully loads.

Unlit
Part 5: 200i Server Maintenance and Diagnostics 27
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Server status after installation

After the server has been installed, the LED status indicators are as follows

LED activity Explanation

The Status LED is lit. The 200i server is not in use and can be removed fro
the shelf. The LED also lights up during the initial 10–
15 seconds of a warm reboot.

The Status LED is 
unlit.

The 200i server is in use, or is booting.

The Status LED is 
unlit but the hex 
display is working.

One or more of the following apply:

� The 200i server motherboard is faulty.

� The LED is faulty.
28 CallPilot
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Understanding the hex display

Introduction

The hex display is located on the faceplate of the 200i server, under the MP
slots.

The server’s hex display is controlled exclusively by the server. This display
does not respond to any input commands from the switch console.

Hex display functions

The hex display gives a visual indication of current server status:

� error code indication of bootup fault conditions

� error code indication of the highest severity event being experienced by
server

Server boot sequence indicators

When the server is inserted into an IPE shelf, the hex display moves throug
following sequence:

Note: XX represents a two-digit number.

Activity Hex display status

The server is not locked into the IPE shelf. Blank

The server is inserted into the switch and receives 
power.

Lights and begins T:XX 

The bootup sequence begins (diagnostics are 
being run).

Continues to display T:XX
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Server status after boot sequence

After the server is installed and the boot sequence completes, the current s
of the server is shown on the hex display.

Note: Some MIN, MAJ, and CRI events might appear because the server ha
been configured, and might be resolved after running the Configuration Wiz
which is described in Part 3 of this binder. The BOOT, PASS, WARN, and FA
messages are system ready indicator messages, and do not appear if the 
Configuration Wizard has not been run. 

Note: XX represents a two-digit number.

Hex display output Description

T:XX The 200i server is booting up and 
running diagnostics. These diagnostics
are performed during a cold reboot 
(when the server is powered up, or if 
you press the Reset button). See 
“Diagnostic codes” on page 32 for more 
details.

F:XX At least one noncritical diagnostic failed
(error code represents the first failed 
diagnostic).

DOWN The operating system is starting up or 
shutting down.

OK The operating system boot sequence ha
passed.

BOOT CallPilot is starting up and is not yet 
fully operational. 

PASS CallPilot is fully operational and ready 
to accept calls.
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Note: If anything else appears on the display, contact your Nortel Networks
technical support organization.

WARN CallPilot is ready to accept calls. 
However, some services failed the boot
sequence. Check the event log for 
further information. 

FAIL CallPilot failed the boot sequence and 
cannot accept calls. Check the event lo
for further information. 

MIN A minor alarm has occurred. Check the
event log for further information. 

MAJ A major alarm has occurred. Check the
event log for further information. 

CRI A critical alarm has occurred. Check the
event log for further information. 

??? This indicates that an alarm of unknow
severity occurred. This error should not
occur on a properly installed system. 
The severity of this event is treated as 
higher-than-critical.

Hex display output Description
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Diagnostic codes

Introduction

The diagnostic tests described here are performed during a cold reboot (wh
the server is powered up, or if you press the Reset button). Diagnostic code
divided into the following three categories:

� critical bootup diagnostics

� noncritical bootup diagnostics

� noncritical operating system and switch diagnostics

Critical bootup diagnostics

All critical bootup diagnostics must pass before the 200i server can proceed
the bootup sequence. If a critical diagnostic fails, the bootup sequence 
indefinitely halts and an error code displays. 

Critical bootup diagnostic codes
The following table shows the critical bootup diagnostic codes with their 
corresponding failure codes. Failure of these diagnostics means that there 
been a server failure. The boot cycle is halted.

Note: The tests for T:00 to T:05 occur instantaneously, so you might not see
these test codes. 

Test code Test description Failure code

T:00 Initialization F:00

T:01 Internal RAM F:01

T:02 ALU F:02

T:03 Address modes F:03

T:04 Boot ROM F:04

T:05 Timers F:05
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Noncritical bootup diagnostics

If a noncritical diagnostic fails, the server continues to boot up. The failure c
corresponding to the first failed test appears on the hex display for three sec
after all noncritical bootup diagnostics have completed (up to T:17). If more t
one diagnostic fails, only the error code of the first failed test appears.

Noncritical bootup diagnostic codes
The following table shows the noncritical bootup diagnostic codes with their
corresponding failure codes. Diagnostic failures in this case do not affect 
completion of server bootup. 

Note: When a test is successfully completed, the next test code appears. 

Test code Test description Failure code

T:06 Watchdog F:06

T:07 External RAM F:07

T:08 Host DPRAM F:08

T:09 DS30 DPRAM F:09

T:10 Software feature key (dongle) F:10

T:11 Flash memory F:11

T:12 PCI FPGA programming F:12

T:13 DS30 FPGA programming F:13

T:14 CEMUX FPGA programming F:14

T:15 DSP FPGA programming F:15

T:16 CEMUX interface F:16

T:17 EEPROM F:17
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Noncritical operating system and switch diagnostics

The 200i server Fault Management Test is an indicator for the highest seve
minor, major, or critical event logged by the software. This is the only 
noncritical operating system and switch test that generates a failure messag
the hex display. 

If a noncritical operating and switch diagnostic test fails, the hex display stop
the failed test. Remaining diagnostics are not performed. The boot sequenc
continues, but server functionality can be compromised.

Noncritical operating system and switch diagnostic error codes
The following table shows the noncritical operating system and switch 
diagnostic codes with their corresponding failure codes. Diagnostic failures 
this case do not affect completion of server bootup:

As soon as the T:18 diagnostic test completes, look for OK. Tests after T:18
complete quickly, so you might not see them on the display. If OK does not 
appear but the display remains at a T:18 or higher code, then the correspon
test has failed. See “Server status after boot sequence” on page 30 for other 
messages that can appear on the hex display.

ATTENTION Until you program the switch (instructions are in Part 3 of th
binder), the hex display might stop between T:18 and T:21, 
which is when the handshaking with the switch begins. Afte
you program the switch, press the Reset button on the 200i
server faceplate to reboot and to clear this fault code.

Status code Operation description Failure code

T:18 OS boot T:18

T:19 CEMUX bus and OS driver T:19

T:20 OS driver application active T:20

T:21 Switch and cardLAN config T:21

T:22 Bootup is complete. 200i server fault 
management takes over.

OK
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Section B: Diagnosing server bootup 
problems

In this section
 What to do when the 200i server fails to boot 36

 Power-On Self-Test (POST) diagnostics 37

 Viewing event logs 42
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What to do when the 200i server fails to boot

To determine why the 200i server failed to boot up

1 Verify the modem DIP switches. For the settings, refer to Part 2 of this 
binder for modem DIP switch settings.

Note: DIP switch 4 is particularly important. If it is not set correctly, the 200i 
server will fail to boot.

2 Try rebooting the server by pressing the reset button on the 200i server 
faceplate.

3 Allow 20 to 30 minutes for the boot cycle to complete.

4 Look at the diagnostic codes on the hex display. See “Diagnostic codes” on 
page 32.

5 Look at the BIOS POST diagnostic results for failures. See “Power-On Self-
Test (POST) diagnostics” on page 37.

Note: Use Console Redirection for this. See Section E: “Working with 
Console Redirection,” on page 71.

6 Attach a local VGA monitor and determine where in the boot cycle the 
failure occurs.

Note: Use Console Redirection for this.

7 If the server boots up, but the hex display shows MIN, MAJ, or CRI, check 
the event logs for more information. See “Viewing event logs” on page 42.

8 If you still cannot find the boot failure cause, call your Nortel Networks 
product support representative.
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Power-On Self-Test (POST) diagnostics

Introduction

The Power-On Self-Test (POST) runs after T:18 completes. POST is a syst
diagnostic program (stored in the BIOS) that runs every time the 200i serve
reboots. POST tests system components, and then displays status messag
locally connected monitor or through Console Redirection.

Viewing bootup results

The BIOS boot screen, as well as POST code diagnostic failure text, can be
viewed locally or remotely by using one of the following methods:

� Attach a local VGA monitor to the 200i server faceplate.

� Use Console Redirection to view text locally or remotely.

Successful bootup example

The following is a typical successful 200i server BIOS boot screen. The exa
phrases can vary based on

� the BIOS version being used

� whether mouse and keyboard devices are attached

� whether the flash recovery PC card is inserted

The text that is underlined is displayed only during cold boots. Cold boots a
generated by 

� removing or reinserting the 200i server from the switch

� manually pressing the reset button on the 200i server’s faceplate

Therefore, extensive BIOS POST memory tests are performed only on cold
boots. 

Phoenix PicoBIOS Version 4.05.03

Copyright 1985-1998 Phoenix Technologies Ltd., All 
Rights Reserved.
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11/16/98 12:40:14

Northern Telecom Ltd., NTRH13BA-01

CPU = Pentium with MMX  166 MHz

0000640K System RAM Passed

0130048K Extended RAM Passed

0256K Cache SRAM Passed

System BIOS shadowed

Video BIOS shadowed

UMB upper limit segment address: F192

Fixed Disk 0: ST92130AG

Mouse Initialized

Phoenix PicoCard (tm) PC Card Boot

(C) Copyright Phoenix Technologies Ltd. , 1997, All 
Rights Reserved

Initializing PicoCard BIOS Socket Services …

Found Cirrus Logic PD6730 PCI-PCMCIA Controller.

Read I/O Address as: 03E0

Initialization of PicoCard BIOS Socket Services 
completed.

No bootable PCMCIA Card found in socket 0.

Press <F2> to enter SETUP, <ALT> to bypass PC Card boot
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Successful bootup description

The following is a line-by-line description of successful bootup results:

Line(s) Description

1–3 Indicate the BIOS vendor, BIOS core version number, and d
and time the BIOS was installed in the system.

5 Indicates the Nortel Networks product code for the product.

6 Indicates the CPU type and speed.

7 Indicates that memory tests on the first 640 bytes of dynamic
RAM passed successfully.

8 Indicates that memory tests on the remaining 127 Mbytes of
dynamic RAM passed successfully.

9 Indicates that memory tests on cache static RAM memory 
passed successfully.

10–12 Indicate that the BIOS was successfully copied into dynamic
memory.

13 Indicates that the hard disk drive was successfully detected, 
when queried, returned the ST92130AG version identifier 
string.

14 Indicates that a mouse was successfully detected and initial

17–23 Indicate that a BIOS extension initialized correctly. The BIOS
extension successfully detected and initialized the onboard 
PCMCIA controller.

24 Indicates that the Flash Recovery PC card was either not 
inserted properly or, if inserted, has been damaged. As a res
the BIOS attempts to boot from a hard disk drive.
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POST diagnostic failures 

If there was a POST diagnostic failure, the BIOS displays additional messag
possible. The following are examples of typical error messages that might 
display:

� 0000640K System RAM Failed at offset: 0F3A

� 0000922K Shadow RAM failed at offset: 00BA

� Memory Testing Aborted

� System cache error - Cache disabled

� SMART Failure Predicted on Hard Disk 0

� Operating system not found

� Keyboard controller error

� Stuck Key

If the failure is noncritical, the BIOS displays failure information text but doe
not halt the boot cycle. The system might or might not boot, depending on t
nature and severity of the underlying hardware failure.

If the failure is diagnosed to be a critical failure, failure information text appe
and the boot cycle stops. The following message always appears as part of
failure information text:

POST error! Press <F1> to resume, <F2> to Setup

27 Provides information on how to perform the following actions

� Enter the BIOS CMOS setup screens to change or verify 
BIOS settings and enable or disable BIOS features (for 
example, Console Redirection).

� Allow booting from the 200i server’s hard drive despite 
having a flash recovery PC card inserted.

Line(s) Description
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What to do if a POST diagnostic failure occurs

If a POST failure occurs, write down any failure messages and contact you
Nortel Networks product support representative.

To see if the problem reoccurs, reboot the 200i server by pressing the rese
button on the 200i server’s faceplate. 
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Viewing event logs

Introduction

When the 200i server boot cycle is complete and if the CallPilot server has 
configured (see Part 3 of this binder), the hex display should show PASS. If
hex display shows CRI, MAJ, or MIN instead, a fault has occurred. To determ
what happened, you can use the following:

� Windows NT Event Viewer on the 200i server (see “To use the Windows 
NT Event Viewer on the 200i server” on page 43)

� Event Browser on the administrative client PC (refer to the Monitoring and 
Security for the Administrator guide for instructions) 

� Alarm Monitor on the administrative client PC (refer to the Monitoring and 
Security for the Administrator guide for instructions)

Note: The Event Browser and Alarm Monitor include online Help for events th
might help you resolve the problem. If you cannot log on to the CallPilot sys
from the administrative PC due to server problems, use the Windows NT Ev
Viewer.
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To use the Windows NT Event Viewer on the 200i server

1 Click Start > Programs > Administrative Tools > Event Viewer.

Result: The Event Viewer window appears.

2 Do one of the following:

� Select Log > System to view the System Log.
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� Select Log > Application to view the Application Log.

Result: The log appears.

Note: The following is an example of the Application Log:

3 Look for any error codes flagged with or that have occurred since the 
last boot.

Note: Each error is date and time stamped.  indicates major or critical 
errors.  indicates minor errors.
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4 To determine the cause of the error, double-click the error.

Result: A description of the error appears.

5 Use the description to fix easily solvable errors.

Note: If the error persists or does not suggest a solution, contact your 
Nortel Networks support representative.

6 Click Close. 

Result: The event log reappears.

7 Select Log > Exit.

Result: The Event Viewer closes.
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Where to get more information

For more information about using the Windows NT System Event Viewer, c
Help > Contents in the Event Viewer window.
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Section C: Viewing installation and 
configuration log files

In this section
 Viewing installation and configuration log files 48
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Viewing installation and configuration log files

Installation or upgrade event log file

The installation event log tracks events associated with any install, reinstall
upgrade, or uninstallation operation. This log also tracks any fatal errors tha
interrupt these operations. 

Use any text editor (for example, Notepad) to view the installation event log
located on the server in C:\sysops\sysops.log. 

Configuration Wizard log file

Use any text editor (for example, Notepad) to view the Configuration Wizard
file located on the server in D:\ Nortel\ConfigWizard\ConfigWiz.log.
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Section D: Performing Windows NT 
online diagnostics

In this section
Overview 50

Checking hardware using Windows NT 4.0 diagnostics 51

Invoking the chkdsk utility 55

Invoking and interpreting TCP/IP diagnostics 57

Invoking and interpreting Token Ring card diagnostics 69
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Overview

Introduction

This section outlines how to access the run-time online diagnostics provide
the Windows NT server software.
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Checking hardware using Windows NT 4.0 
diagnostics

Introduction

The Windows NT 4.0 system provides tools that can be used to diagnose a
debug system problems, including

� Windows NT Diagnostics screen

� Event Viewer

Windows NT Diagnostics window

The Windows NT 4.0 Diagnostics window allows you to view details 
concerning the system and network components. 

You can open the following tabs on the Diagnostics window to display spec
information: 

� Version 
� System
� Display
� Drives
� Memory
� Services
� Resources
� Environment
� Network
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 Windows NT Diagnostics main window

To access Windows NT 4.0 diagnostic tools

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Windows NT 
Diagnostics to access the Windows NT Diagnostics window.

3 Select the appropriate tab on the Diagnostics main window to view 
information concerning the system and network. Details available on each 
tab are supplied in the following table:
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Select To display details about

Version Version
Registration

System System identifier
HAL
BIOS information
Processors

Display BIOS information
Adapter
Driver

Drives Drives by type or letter

To view specific details, select a drive, and then press 
Properties to view details for the drive, including size, 
labels, and so on.

Memory Memory, including totals, physical and kernel memory, 
commit charge, kernel

Services Service and state for both services and devices

To view specific details, select a service, and then 
press Properties to view details, including pathname, 
dependencies, service flags, and so on.

Resources Select one of the following buttons to display 
information about the resources available on the 
system:

� IRQ

� I/O Port

� DMA

� Memory 

� Devices

To view specific details, select a resource, and then 
press Properties.
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Event Viewer

Windows NT 4.0 provides an Event Viewer that is used to view event logs to
assist in diagnosing and debugging system problems.

Three types of event logs are available from the Event Viewer, as follows:

To access the Event Viewer

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Event Viewer.

3 Select the appropriate tab to view the associated event logs.

Environment Variable and value for both system and local user

Network Select one of the following buttons to display 
information about the network and components:

� General 

� Transports 

� Settings 

� Statistics 

System Logs events by Windows NT 4.0 components, 
including RAS or other WinNT services.

Security Logs security events, such as logons, logoffs, 
illegal access, and so on. This option is available
only to users with Administrative access.

Applications Logs events by application, such as database fi
errors, and so on.

Select To display details about
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Invoking the chkdsk utility

Introduction

The chkdsk utility checks a specified disk on the server and displays a statu
report. Use this utility on the C or D drive.

Note: A version of this utility, called autocheck, automatically runs at Window
NT boot-time. Output from this utility appears on the startup blue screen.

Chkdsk utility syntax

The chkdsk utility uses the following syntax:

chkdsk [drive:][path]filename] [/F] [/V] [/R]

To run the chkdsk utility from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type chkdsk <drive letter:>  (for example, chkdsk 
c:).

Parameters Description

[drive:] The drive letter of the drive you want to check.

filename The names of files to check for fragmentation.

/F Add this switch to fix errors on the disk.

/V Add this switch to display the full pathname of 
every file on the disk.

/R Add this switch to locate bad sectors and to 
recover readable information.
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3 Press Enter.

Result: The system runs the chkdsk utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting TCP/IP diagnostics

Introduction

This section outlines the following TCP/IP diagnostic tools available for the 
Ethernet card. The first three tools are the most useful:

� ipconfig

� ping

� tracert

� arp

� nbtstat

� netstat

The ipconfig command

The ipconfig command displays IP configuration information. 

Ipconfig default
Running the command without flags displays the IP address, subnet mask,
default gateway for each adapter bound to TCP/IP.

Ipconfig command syntax
ipconfig /[]

The following flags are available for the ipconfig command:

Flag Description

/? Displays Help information.

/all Displays full configuration information.

/release Releases the IP address for the specified 
adapter.
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To run the ipconfig command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ipconfig <with appropriate parameters:>  
(for example, ipconfig /all).

3 Press Enter.

Result: The system runs the ipconfig utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

/renew Renews the IP address for the specified 
adapter.

Flag Description
58 CallPilot



May 2000 Diagnosing the server
The ping command

The ping command sends an echo request to a specified host.

Ping command syntax
The ping command uses the following syntax:

ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]

        [-r count] [-s count] [[-j host-list] | [-k host-list]]

        [-w timeout] destination-list

Parameters Description

-t Pings the specified host until interrupted.

-a Resolves addresses to host names.

-n count Specifies the number of echo requests to send.

-l size Sends buffer size.

-f Set Don’t Fragment flag in packet.

-i TTL Time To Live.

-v TOS Type Of Service.

-r count Record route for count hops.

-s count Time stamp for count hops.

-j host-list Loose source route along host list.

-k host-list Strict source route along host list.

-w timeout Timeout in milliseconds to wait for each reply.
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To run the ping command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ping <destination IP address:>  (for 
example, ping 47.286.32.0:).

3 Press Enter.

Result: The system indicates a successful ping.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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The tracert command

This utility determines the route taken to a destination.

How tracert works
The tracert utility follows several steps to complete its task:

� Tracert sends Internet Control Message Protocol (ICMP) echo packets 
varying Time-To-Live (TTL) values to the destination.

� Each router along the path must decrement the TTL on a packet by at 
1 before forwarding it, so the TTL is effectively a hop count. 

� When the TTL on a packet reaches 0, the router sends back an ICMP 
Exceeded message to the source system.

� Tracert determines the route by sending the first echo packet with a TT
1 and incrementing the TTL by 1 on each subsequent transmission unti
target responds, or the maximum TTL is reached. 

� Tracert then examines the ICMP Time Exceeded messages sent back 
intermediate routers.

Tracert syntax
tracert [-d] [-h maximum_hops] [-j host_list] [-w timeout] [target_name]

Tracert parameters
The tracert command uses the following parameters:

Parameter Description

-d Specifies not to resolve addresses to 
hostnames.

-h maximum_hops Specifies the maximum number of hops to 
search for target.

-j host-list Specifies a loose source route along the 
host list.

-w timeout Waits the number of milliseconds 
specified by the timeout for each reply.
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To run the tracert command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type the following command:

tracert [-d] [-h maximum_hops] [j host_list] [-w timeout] [target name]  

(for example, tracert 47.286.0.32 210 47.236.0.04)

3 Press Enter.

Result: The system runs the tracert utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

target_name The name of the target host.

Parameter Description
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The arp command

The arp command displays and modifies the IP-to-physical address transla
tables used by Address Resolution Protocol (arp).

Arp command syntax
The arp command uses the following syntax:

arp -s inet_addr eth_addr [if_addr]

arp -d inet_addr [if_addr]

arp -a [inet_addr] [-N if_addr] 

Parameter Description

-a Displays current arp entries by interrogating 
the current protocol data. If inet_addr is 
specified, the IP and physical addresses for 
only the specified computer appear. If more 
than one network interface uses arp, entries for 
each arp table appear.

-g Same as -a.

inet_addr Specifies an Internet address.

if_addr Specifies the Internet address of the interface 
whose address translation table should be 
modified. If not present, the first applicable 
interface is used.

eth_addr Specifies a physical address.

-N if_addr Displays the arp entries for the network 
interface specified by if_addr.

-d Deletes the host specified by inet_addr.
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To run the arp command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type arp with the required parameters (for 
example, arp -g 47.286.0.32).

3 Press Enter.

Result: The system runs the arp command.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Adds the host and associates the Internet 
address inet_addr with the Physical address 
eth_addr. The physical address is given as six 
hexadecimal bytes separated by hyphens. The 
entry is permanent.
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The nbtstat command

The nbtstat command displays protocol statistics and current TCP/IP 
connections using NBT. This command is available only if the TCP/IP proto
is installed.

Nbtstat command syntax
The nbtstat command uses the following syntax:

nbtstat [-a remotename] [-A IP address] [-c] [-n] [-R] [-S] [-s] [interval]

Parameter Description

-a remotename Lists the remote computer’s name table using 
its name.

-A IP address Lists the remote computer’s name table using 
its IP address.

-c Lists the contents of the NetBIOS name cache 
giving the IP address of each name.

-n Lists local NetBIOS names. Registered 
indicates that the name is registered by 
broadcast (Bnode) or WINS (other node 
types).

-R Reloads the LMHOSTS file after purging all 
names from the NetBIOS name cache.

-r Lists name resolution statistics for Windows 
networking name resolution. On a Windows 
NT computer configured to use WINS, this 
option returns the number of names resolved 
and registered through broadcast or through 
WINS.

-S Displays both client and server sessions, 
listing the remote hosts by IP address only.
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To run the nbtstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type nbtstat with the required parameters.

3 Press Enter.

Result: The system runs the nbtstat utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Displays both client and server sessions, and 
attempts to convert the remote host IP address 
to a name using the HOSTS file.

interval Displays selected statistics, pausing interval 
seconds between each display. Press CTRL+C 
to stop displaying statistics. Without this 
parameter, nbtstat prints the current 
configuration information once.
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The netstat command

The netstat command displays current TCP/IP network connections and pro
statistics.

Netstat command syntax
The netstat command uses the following syntax:

netstat [-a] [-e] [-n] [-s] [-p proto] [-r] [interval]

To run the netstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type netstat with the required parameters.

3 Press Enter.

Result: The system runs the netstat utility.

Parameter Description

-a Displays all connections and listening ports.

-e Displays Ethernet statistics. This can be 
combined with the -s option.

-n Displays addresses and port numbers in 
numerical form.

-s Displays per-protocol statistics. 

-p proto Shows connections for the protocol specified 
by proto. Proto can be tcp or udp. If used with 
the -s option, proto can be tcp, udp, or ip.

-r Displays the contents of the routing table.

interval Redisplays selected statistics, pausing 
between each display. Press CTRL+C to stop 
redisplaying.
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4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting Token Ring card 
diagnostics

Introduction

If TCP/IP protocol is installed, you can diagnose faults on the Token Ring c
by using the ping command under Windows NT.

Using the ping command

Instructions for using the ping command are in the procedure “To run the ping 
command from Windows NT 4.0” on page 60.
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Section E: Working with Console 
Redirection

In this section
 About Console Redirection 72

 Console Redirection requirements 75

 Setting up a direct serial connection 77

 Setting up a modem connection 80

 Using Console Redirection 82
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About Console Redirection

Introduction

Console Redirection is a remote control feature provided by the Phoenix 
Technologies BIOS. With Console Redirection, you can be located anywhe
provided you have a modem and can connect to the 200i server through a p
switched telephone network (PSTN). By doing so, it appears as if you are si
right next to the 200i server with a local monitor, keyboard, and mouse attac
to the server’s faceplate.

With Console Redirection, you can do the following:

� Enter BIOS CMOS Setup to query, alter, or restore BIOS settings.

� Watch BIOS POST Diagnostics execute, and see their completion statu

� Force warm boots, cold boots, and diagnostic boots.

� Run MS-DOS–based diagnostics and use MS-DOS utilities and feature

Difference between Console Redirection and pcANYWHERE32

Console Redirection provides MS-DOS–based remote control as well as pr
Windows NT bootup remote control. pcANYWHERE32 provides post-
Windows NT bootup remote control. 

The following table describes when Console Redirection and pcANYWHERE
can be used during the boot cycle:

Boot phase Remote control tool

BIOS and MS-DOS During BIOS and MS-DOS bootup, you can u
Console Redirection to control the boot cycle.

Windows NT While Windows NT is booting, you cannot see
or control what the boot cycle is doing. This is 
called a blackout period.
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When to use Console Redirection

Typically, you use Console Redirection when you want to 

� investigate bootup problems

� control bootup behavior

� perform any of the actions listed under “Using Console Redirection” on 
page 82

Where Console Redirection can be used

Console Redirection can be used in the following scenarios:

� You are local to the 200i server, but a monitor and keyboard or mouse 
not connected.

� You are not local to the 200i server but have a modem connected to a P
(This requires that the 200i server also be equipped with a modem.)

Restrictions

With Console Redirection, the following restrictions apply:

� When the 200i server displays the Windows NT/DOS boot selection me
this screen cannot be viewed, nor can all subsequent Windows NT scree
This means that the Windows NT boot cycle cannot be seen or control

� Colors are not displayed.

� You cannot perform 200i server BIOS upgrades with Console Redirecti
You must perform upgrades using a local mouse, monitor, and keyboar

CallPilot server software While the CallPilot server software is booting
you can use pcANYWHERE32 software to 
watch the boot cycle. When bootup is 
completed, you can use pcANYWHERE32 to 
administer the 200i server.

Boot phase Remote control tool
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ures 
� 200i server operating system installation and hard disk recovery proced
must be performed using a local mouse, monitor, and keyboard.
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Console Redirection requirements

Introduction

Console Redirection can be used from two connection scenarios:

� direct serial connection (total setup time is five minutes)

� modem connection (total setup time is five minutes)

This section describes the requirements of these scenarios.

Direct serial connection requirements

General requirements
You must be local to the 200i server and have access to its I/O breakout pa
All call processing must be stopped, and the 200i server must be rebooted.

Hardware requirements

� administration client PC or laptop with a free communication port (for 
example, COM1)

� RS-232 9-pin female to 9-pin female serial cable

� null modem device

� gender benders (if required)

Software requirements on the 200i server
The 200i server must have Console Redirection enabled in the BIOS CMOS
setup.   For instructions, see “To reenable Console Redirection” on page 214.

Software requirements on the client PC or laptop
The client PC or laptop must be running Windows NT 4.0, Windows 95, or 
Windows 98, and HyperTerminal must be installed.
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Modem connection requirements

General requirements

� You must stop all call processing and reboot the 200i server.

� You need the phone number of the 200i server modem.

� You need the RAS passwords to invoke a remote pcANYWHERE32 
session to remotely perform a 200i server Windows NT shutdown and 
restart.

Hardware requirements

� The administration client PC must have a high-speed modem capable 
19200 bps.

� The 200i server must have a high-speed modem capable of 19200 bps

� The modem must be powered on and configured correctly. 

� You need access to a PSTN.

Software requirements on the 200i server
Console Redirection must be enabled in 200i server BIOS CMOS Setup.

Software requirements on the administration client PC or laptop

� The administration client PC or laptop must be running Windows NT 4.
Windows 95, or Windows 98.

� Dial-Up Networking must be configured.
76 CallPilot



May 2000 Diagnosing the server

out 

nt 
Setting up a direct serial connection

Introduction

A direct serial connection is achieved by 

� connecting the client PC to the COM1 port of the 200i server I/O break
panel

� establishing connection with the 200i server using HyperTerminal

Before you can perform these tasks, you need to 

� ensure that a HyperTerminal connection profile is configured on the clie
PC

� shut down the 200i server

To configure the client PC

1 Determine which COM port is free on the client PC (COM1 or COM2).

2 Start HyperTerminal by clicking Start > Programs > Accessories > 
HyperTerminal > HyperTerminal.

Note: If HyperTerminal is not present, you must install it. Install 
HyperTerminal as follows:

a. Click Start > Settings > Control Panel. 

b. Double-click Add/Remove Programs.

c. Click the Windows NT or Windows 95 tab. 

d. Click Accessories.

e. Click OK.

Note: You might be prompted to insert your operating system CD.

Result: The HyperTerminal window appears, asking you to enter a name.

3 Enter a name for the new connection profile, and then click OK.

Result: The Connect To dialog box appears.
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4 Under Connect using, select the COM port that you previously identified as 
free from the drop-down list, and then click OK.

Result: The Properties window appears.

5 Select the following settings from the drop-down menus, and then click OK:

� Bits per second: 19200

� Data bits: 8

� Parity: N

� Stop bits: 1

� Flow Control: Xon/Xoff

6 Click OK.

Result: Your terminal session begins.

To shut down the 200i server

1 Courtesy stop or stop all 200i server DSP ports. See “Starting and stopping 
components” on page 112.

2 If a modem is connected to the 200i server, before shutting down, ensure 
that no one is currently using the modem to administer the 200i server.

3 Invoke a 200i server Windows NT shutdown, and restart.

To connect the serial cable

1 Temporarily disconnect the modem’s serial cable from the I/O breakout 
panel’s COM1 connector.

2 Connect one end of the RS-232 serial cable to the I/O breakout panel’s 
COM1 connector.

3 Connect the other end of the cable to the null modem device.

4 Connect the null modem device to the client PC’s COM port that was set up 
in “To configure the client PC” on page 77.

Note: You might need to use gender benders.

5 Restart the server by pressing the reset button on the 200i server faceplate. 
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6 Wait until the red status LED blinks three times.

Result: From the client PC, you should now be able to view and take 
control of the server. See “Using Console Redirection” on page 82.

7 When you are finished, disconnect the serial cable from the I/O breakout 
panel’s COM1 connector.

8 Reconnect the modem to the I/O breakout panel’s COM1 connector.

9 Disconnect the serial cable from the administration client PC.

10 Exit the administration client’s HyperTerminal session by choosing File > 
Exit.

Tip: Before exiting, you can save the HyperTerminal session settings for 
future use by selecting File > Save As. Restore the session by choosing 
File > Open and specifying the saved file name.

11 Ensure that the 200i server boots up and the hex display shows OK, MIN, 
MAJ, or CRI.

12 Restart 200i server DSP ports. See “Starting and stopping components” on 
page 112.
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Setting up a modem connection

Introduction

A modem serial connection is achieved by 

� ensuring that the client PC is configured with Dial-Up Networking

� connecting to the 200i server and shutting it down

� hanging up, and then reconnecting to the 200i server with Dial-Up 
Networking (with terminal window)

To configure the administration client PC

Configure the administration client PC to use Dial-Up Networking. Refer to 
Monitoring and Security for the Administrator guide for instructions.

To shut down the 200i server

1 Establish a RAS connection.

Note: Refer to the Monitoring and Security for the Administrator guide for 
instructions.

2 Remotely courtesy stop or stop all 200i server call processing using the 
RAS connection.

3 Force the 200i server to do a Windows NT shutdown and restart.

Note: Refer to the Monitoring and Security for the Administrator guide for 
instructions.

To configure the modem properties on the administration client PC

1 Hang up the current Dial-Up Networking connection.

2 Click Start > Settings > Control Panel.

Result: The Control Panel appears.

3 Double-click Modems.

Result: The Modem Properties dialog box appears.
80 CallPilot



May 2000 Diagnosing the server
4 Select the modem.

5 Click Properties.

6 Click Connection.

7 Reconfigure the client PC’s modem to use the following settings:

� Bits per second: 19200

� Data bits: 8

� Parity: N

� Stop bits: 1

� Flow Control: Xon/Xoff 

8 Reestablish a RAS connection with the 200i server.

Note: The Dial-Up Networking connection profile properties should be 
configured to open a terminal window. To open a terminal window, do the 
following:

a. Right-click the Dial-Up Networking connection icon you are using.

b. Click Properties.

c. Under Connect using (on the General tab), click Configure.

Result: The connection profile’s Modem Properties dialog box appears.

d. Click the Options tab.

e. Click one of the following:

� Bring up terminal window before dialing

� Bring up terminal window after dialing

f. Click OK.

Result: From the client, you should now be able to view and take control of 
the server. See “Using Console Redirection” on page 82.

9 When you are finished, hang up and reset the modem properties back to 
their original settings.

10 Reestablish a RAS connection with the 200i server, and reenable call 
processing.
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Using Console Redirection

Introduction

You can use Console Redirection to watch and control the 200i server bootup 
cycle until Windows NT starts to load. 

Types of boots

There are three types of boots: 

� Warm boots are Ctrl-Alt-Del type boots. 

� Cold boots are almost equivalent to a power down except that the boot
diagnostics do not run. Cold boots perform many more POST diagnost
tests than warm boots. 

� Diagnostic boots are similar to cold boots except that they are even mo
intensive, and try to get your system up and running regardless of how
many POST diagnostics fail.

OA&M tasks

You can use Console Redirection to perform the following OA&M tasks:

Task How to perform the task

Enter BIOS CMOS Setup to query, alter, 
or restore BIOS settings.

Press F2 to enter setup when the following 
message appears:

 Press <F2> to enter setup or 
<ALT> to bypass PC Card boot  

Watch BIOS POST diagnostics execute 
and see their completion status.

BIOS POST diagnostics automatically appea
when a connection is established early in th
boot cycle. If the BIOS screen was missed, 
you can boot to DOS and type coldboot.exe 
at the C:\>  prompt.
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Force warm boots, cold boots, and 
diagnostic boots. 

Note: See “Types of boots” on page 82 for 
descriptions.

Do one of the following:

� During the BIOS POST diagnostics, pres
one of the following key sequences: 

� Ctrl-C: to perform a cold 
boot

� Ctrl-W: to perform a warm 
boot

� Ctrl-D: to perform a 
diagnostic boot

� Boot to DOS and type coldboot.exe at the 
C:\>  prompt.

Run MS-DOS–based diagnostics, and use 
MS-DOS utilities and features (for 
example, ELAN and CLAN NIC 
diagnostics, network access, SCSI 
CD-ROM access, and utilities such as 
chkdsk.exe, edit.exe, sys.exe, and so on, 
while in MS-DOS).

During the boot sequence, you are asked to
choose between booting to MS-DOS or to 
Windows NT. Select MS-DOS. 

Task How to perform the task
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Using the Administrative PC to 
diagnose the server

In this chapter
 Overview 86

Section A: Detecting, isolating, and fixing hardware problems 87

 Overview 88

 Detecting hardware problems 89

 Viewing events and isolating problems 90

 Checking channel status 93

Section B: Working with the Maintenance window 97

 Overview 98

 Introducing the Maintenance window 99

 Obtaining general information about components 107

 Viewing component states 109

 Starting and stopping components 112

 Running integrated diagnostics 116

 Viewing last diagnostic results 119

 Obtaining replacement part numbers 122
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Overview

Introduction

This chapter provides information on how to detect, isolate, and fix hardwar
problems on the CallPilot server using the CallPilot Administration Client 
software on the administrative PC.

� The section “Detecting, isolating, and fixing hardware problems” on page 
87 provides details on how to detect, isolate, and fix hardware problem

� The section “Working with the Maintenance window” on page 97 describes 
how to use the Maintenance window as you detect, isolate, and fix 
hardware problems.

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system. References to the SCbus, Master Timeswitch, and MPB ar
applicable to the 200i server.
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Section A: Detecting, isolating, and 
fixing hardware problems

In this section
 Overview 88

 Detecting hardware problems 89

 Viewing events and isolating problems 90

 Checking channel status 93
Part 5: 200i Server Maintenance and Diagnostics 87



Using the Administrative PC to diagnose the server  Standard 1.0

or 

ms.

 
ix 

s 

 go 

e, 

ls

ls

me 

e

Overview

Introduction

This section provides guidelines on how to detect, isolate, and fix potential 
real hardware problems. 

� “Detecting hardware problems” on page 89 provides information on the 
different ways in which you typically become aware of hardware proble

� “Viewing events and isolating problems” on page 90 describes how to work 
with the Alarm Monitor, Event Browser and Maintenance screen. These
tools are used to isolate the cause of problems and plan a strategy to f
hardware problems.

� “Checking channel status” on page 93 describes how to view channel statu
in the Channel Monitor and Multimedia Monitor.

Component dependencies

The status of some components depend on the operational status of other 
components. If a component fails or is stopped, the dependent components
out of service. 

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components might not appear on your system. 

Component Dependent components 

SCbus all MPBs, MPCs, and all Multimedia and Call channe

Master Timeswitch all MPBs, MPCs, and all Multimedia and Call channe

Timeswitch all Multimedia and Call channels connected to the sa
MPB as the timeswitch

MPC all multimedia channels on the MPC-8 card

DS30x all Call channels associated with that DS30x link cabl
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Detecting hardware problems

Introduction

Typically, you first become aware of a hardware problem when an alarm is 
raised. All hardware faults produce an alarm (or series of alarms, dependin
the problem) in the Alarm Monitor. 

Note: By default, the Alarm Monitor appears on the screen as soon as an a
is raised. It does not appear if Alerting Off has been set in the CallPilot syst
window. For more information on setting or resetting the alerting feature, re
to the Monitoring and Security for the Administrator guide.

Other indications of a hardware problem

Other indications of a hardware problem include the following:

� user complaints

� call processing difficulties, such as busy signals, static, dropped calls, 
trouble connecting, and cross talk (hearing other conversations)

� system administrator log on difficulties

� alert icons on the Maintenance window
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Viewing events and isolating problems

Introduction

Use one of the following methods to isolate and plan a strategy to fix a hard
problem:

� Go to the Alarm Monitor to investigate one or more raised alarms.

� Use the Event Browser to investigate a series of events that occurred ar
the time an alarm was raised.

� Go to the Maintenance window to get status information for any suspec
components. For some components, you can use the Diagnostic tab o
Maintenance window to run a diagnostic test.

Note: For detailed information on how to use the Alarm Monitor and Event 
Browser (for example, how to set preferences), refer to the Monitoring and 
Security for the Administrator guide.

Using the Alarm Monitor

Each alarm in the Alarm Monitor has Help text that often provides a solution
the problem. If the solution is not apparent, use the Event Browser or the 
Maintenance screen to further investigate the problem.
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To investigate using the Alarm Monitor

1 If the Alarm Monitor is not already visible, then in the CallPilot system 
window, go to System Administration > Alarms and Events > Alarm Monitor.

2 Double-click the first critical or major alarm.

Result: The Help window appears. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more alarms.

5 If the solution to the problem is not apparent, obtain the return code of the 
first event and continue the investigation by using the Event Browser (go to 
“Using the Event Browser” on page 91).

Using the Event Browser

The Event Browser lets you view events that have been recorded in the ser
log. The event listing can help you better determine the root cause of the 
problem. Use the Event Browser to view the time the event occurred, the ob
that generated the event, and the cause of the event.
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To investigate using the Event Browser

1 In the CallPilot system window, go to System Administration > Alarms and 
Events > Event Browser.

2 Double-click an event that appears to be related to the problem, or an event 
that occurred near the time the alarm was raised. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more events.

5 If the solution to the problem is not apparent, contact your distributor.

Using the Maintenance window

If you suspect or discover a problem with an MPC-8 card or the timeswitch,
the Diagnostic tab of the Maintenance window. You can view the results of t
last diagnostic test run against the component. This produces a list of 
components that might be causing the problem. A probability percentage is
listed with each component that reflects how probable it is that replacing th
component will fix the problem. 

For information on using the Maintenance window to view the results of the 
diagnostic test, see “Viewing last diagnostic results” on page 119.

For information on all aspects of the Maintenance window, see Section B: 
“Working with the Maintenance window,” on page 97.
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Checking channel status

Introduction

The Channel Monitor shows the status of call channels (the connection betw
the server and the switch that carries the call signal to CallPilot). 

The Multimedia Monitor shows the status of multimedia channels (the DSP
ports that process the call— these are the voice, fax, and speech recognitio
channels). 

The Channel Monitor and Multimedia Monitor also enable you to start, stop
courtesy stop channels. To run diagnostics on a channel, use the Maintena
window.

Note: For detailed information on how to use the Channel Monitor and 
Multimedia Monitor, refer to the online Help in the CallPilot system window, 
refer to the Monitoring and Security for the Administrator guide.
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To view call channel states

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Channel Monitor.

2 Double-click Channel Monitor.

Result: The Channel Monitor window appears, showing the state of all call 
channels on the system. For an explanation of the channel states, refer to 
the online Help. 
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To view multimedia channels

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Multimedia Monitor.

2 Double-click Multimedia Monitor.

Result: The Multimedia Monitor window appears, showing the state of all 
multimedia channels. For an explanation of the channel states, refer to the 
online Help. 
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Section B: Working with the 
Maintenance window

In this section
 Overview 98

 Introducing the Maintenance window 99

 Obtaining general information about components 107

 Viewing component states 109

 Starting and stopping components 112

 Running integrated diagnostics 116

 Viewing last diagnostic results 119

 Obtaining replacement part numbers 122
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Overview

Introduction

Use the Maintenance window to do the following:

� Obtain general information about components.

� View component states.

� Start and stop components.

� Run integrated diagnostic tests.

� View the results of the last diagnostic test run against a component.
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Introducing the Maintenance window

Introduction

All physical and logical hardware components are listed in the Maintenance
window tree. This tree shows how components relate to each other. For exa
eight multimedia channels exist as subcomponents for each MPC-8 card.

When you select a component in the Maintenance window, at least one of t
following tabs appear:
. 

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system. References to the SCbus, Master Timeswitch, and MPB ar
applicable to the 200i server.

Tab Description

General This page shows general technical 
information about the selected 
component. 

Maintenance This page shows the state of the selected 
component. You can also take some 
components out of service from this page. 

Diagnostics This page enables you to run component-
specific diagnostics.

Replacement This page shows replacement part 
numbers for selected components. This 
option is not available for all platforms. 
Contact your distributor for latest part 
number information.
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The General tab

Use the General tab to view general information about components.

 

Box Description

Attribute Shows component-specific general technical information

Value Shows additional details, such as the speed of a selecte
device.
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The Maintenance tab

Use the Maintenance tab to view the state of the highlighted component an
start and stop a component before running a diagnostic test.
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Box Description

State Specifies the state of the highlighted component.

Administrative This is a Desktop Management Interface (DMI) summar
state. You do not need this state.

Availability This is a DMI summary state. You do not need this state

Operational This is a DMI summary state. You do not need this state

Usage This is a DMI summary state. You do not need this state

Stop Use this button to take the selected device out of servic
immediately. All calls in progress are disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.
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Courtesy stop Use this button to take the selected device out of servic
after all calls are finished. This prevents any calls from 
being disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.

Start Use this button to put the selected device in service.

Power Up Use this button to power up an MPC-8 card that had be
powered down. You can only use this button for MPC-8 
cards on a 200i server. See “To replace MPC cards” on 
page 179.

Power Down Use this button to power off an MPC-8 card prior to 
replacing it. You can only use this button for MPC-8 card
on a 200i server. See “To replace MPC cards” on page 179.

Box Description
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The Diagnostics tab

Use the Diagnostics tab to run a diagnostic test or to view the results of the
diagnostic test run on a component.

Box Description

List of Diagnostics for 
Selected Device

Shows the diagnostic tests that are available for the 
highlighted component.

Run Use this button to run the selected diagnostics. For the 
Timeswitch and MPC components, go to the Maintenan
tab to courtesy stop the component before you run 
diagnostics.

Stop Use this button to stop the selected diagnostics
104 CallPilot



May 2000 Using the Administrative PC to diagnose the server 

le 

tic 

 

Last Result Use this button to view the results of the last diagnostic 
test.

The results include a list of Field Replaceable Units 
(FRU), which, if replaced, might fix the problem. Each 
FRU is shown with a percentage that shows how probab
it is that the component caused the hardware problem.

Description Shows a comment or description for a selected diagnos
test.

Instructions Shows the instructions for the user to run the diagnostic
test.

Box Description
Part 5: 200i Server Maintenance and Diagnostics 105



Using the Administrative PC to diagnose the server  Standard 1.0

s not 
The Replacement tab

The Replacement tab shows component part number information. This tab i
available for all platforms. To be certain you have the latest component 
information, contact your distributor.

Box Description

Description Shows the name of the highlighted component.

Manufacturer Shows the manufacturer of the component.

Model Revision Shows the revision number for the component.

Part Numbe r Shows the part number for the component.

Technical Support URL Shows a web site address where you can get technical 
support.
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Obtaining general information about 
components

Introduction

Find general technical information for each hardware component listed in th
tree using the General tab of the Maintenance window.

For a description of the General tab, see “The General tab” on page 100.

Type of technical information

Technical information about hardware components typically includes details
such as the following:

� the name, class, type, series, or version of a component

� various capabilities of a component (for example, the speed of a CPU)

� the available disk space
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Getting there   CallPilot system > System Administration > Maintenance 
Administration > Maintenance

To view component details

1 From the left pane of the Maintenance window, select the hardware 
component about which you want to obtain information.

Result: The General page appears with general information shown.
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Viewing component states

Introduction

View a component’s state to determine the general condition of the compon
including whether the component is disabled or off duty. You can view the s
of components that are listed in the Maintenance tab of the Maintenance 
window.

For a description of the Maintenance tab, see “The Maintenance tab” on page 
101.

Component states

The state of a hardware component changes depending on the following fac

� whether the component is currently involved in processing a call

� whether a diagnostic test is being run on the component 

� whether the component is out of service 

You can determine the state of a component by looking at the State field in 
Maintenance tab. 

State Description

Active The component is working and currently involved in 
processing a call. 

Idle The component is working but not currently involved in 
processing a call.

Uninstalled The component is not installed or properly configured. Th
usually happens only when the system is being configure
or if the database is corrupted.

Shutting Down The component is in the process of stopping. 

This state occurs quickly and is immediately followed by 
Off Duty.
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Details 
These states (Administrative, Availability, Operational, and Usage) are stan
Desktop Management Interface (DMI) states. They are shown for administra
who understand and use the DMI standard in other aspects of their jobs. Yo
not need to use the DMI states; the summary state listed in the State field is
provided instead. 

Alert icons
If one of the following icons appears next to a component in the tree, the 
component or one of its subcomponents is experiencing a problem:

Loading The component has been started, which takes it out of th
Off Duty state. 

This state occurs quickly and is immediately followed by 
Idle.

No resources The hardware required for the component to operate is n
installed or not operating properly. 

Off duty The component has been stopped.

Remote Off Duty The component has been taken out of service at the swi

Icon Description

 This means that a diagnostic test run on the component has fa
and the component has been placed into disabled status. 

You must view the last results of the diagnostic test. See 
“Viewing last diagnostic results” on page 119.

This means that a problem exists with one of the component’s
subcomponents. 

Expand the tree to locate the subcomponent with the problem

State Description
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To view the state of a hardware component 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 View the state of the selected component in the State field.
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Starting and stopping components

Introduction

When you stop a component, it goes out of service and stops operating. Yo
must either stop or courtesy stop a component before you can run a diagno
test on it. 

When you start a channel, it goes back into service. You must start a chann
after replacing it, or after running a successful diagnostic test, to bring it bac
into service.

Courtesy stop 
A courtesy stop takes the component out of service only after the componen
finished processing the active call. If the component is currently processing
call, the call is not dropped. If the component is not currently in use, it is tak
out of service immediately. This method is preferred over a regular stop.

Stop
A stop takes the component out of service immediately, regardless of wheth
the component is currently processing calls. All active calls are dropped. 
Typically, you perform a stop only when severe problems occur that are affec
a large number of incoming calls, or if your organization determines a spec
need for it.

ATTENTION  Nortel Networks recommends that you courtesy stop a 
component if possible. 

In the Maintenance window, the courtesy stop option is 
available only at the individual channel level. 

To courtesy down CallPilot, use the Multimedia Monitor to 
courtesy stop all DSPs. 

To courtesy stop a range of multimedia channels or all 
multimedia channels on an MPC [DSP] card, use the 
Multimedia Monitor. See “Checking channel status” on page 
93 for an overview of the Channel Monitor and Multimedia 
Monitor.
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Components that can be started and stopped

This section lists components that can be started and stopped.

If you want to start or stop more than one or two multimedia or call channel
use the Channels windows. See “Checking channel status” on page 93 for an 
overview of the Channel Monitor and Multimedia Monitor. For detailed 
information, refer to the Monitoring and Security for the Administrator guide.

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components do not appear or do not have the Stop option: 

. 

CAUTION

Risk of Ring No Answer on disabled (stopped) call channel on 
Lucent, Mitel, or Rolm systems
For CallPilot servers connected to a Lucent, Mitel, or Rolm 
switch, if you stop an individual call channel, the corresponding
port on the switch side is not automatically disabled. As a resul
calls can continue to land on the stopped channel resulting in a
Ring-No-Answer.

If you need to stop an individual channel, you have two options

� Busy-out the port on the switch side. This must be done 
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the call 
channel or courtesy stop all call channels in the system.

This caution does not apply to stopping DSP ports.

Component Effect of stopping

SCbus takes out of service all call processing 
resources

Timeswitch takes out of service the MPB16 card that is 
serviced by the timeswitch
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MPC-8 cards takes out of service the selected MPC-8 
card

Multimedia (DSP) 
channels

takes out of service the selected DSP 
channel

Switch Interface Link 
(found under the Switch 
Interface Card 
component)

takes out of service the selected link to the 
switch

Call channels takes out of service the selected call channel

DS30x link takes out of service the selected DS30x link

Component Effect of stopping
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To start or stop a component in the Maintenance window

1 From the left pane of the Maintenance window, select the hardware 
component you want to start or stop. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

3 Click Start, Courtesy Stop, or Stop. 
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Running integrated diagnostics

Introduction

You should run diagnostic tests from the Diagnostic tab in the Maintenance
window in the following circumstances: 

� After installing or reinstalling a component, make sure it is operating 
properly. (A component must be Off Duty [stopped] before you can run 
diagnostic test. See “Starting and stopping components” on page 112.)

� Run the tests if the CallPilot server experiences trouble processing 
incoming calls. Problems include static, dropped calls, and cross talk 
(hearing another conversation).

Note: For a description of the Diagnostic tab, see “The Diagnostics tab” on page 
104.

List of components that have diagnostic tests available
� MPC (DSPs)

� Timeswitch (depending on the switch type, diagnostics might not be 
available)

To view available diagnostic tests

The available diagnostic tests for each component appear in the Diagnostic
of the Maintenance window. Click a component to see the diagnostic tests 
available for that component. 

If a diagnostic test fails or cannot be run

If a warning box appears, the diagnostic test cannot be run because a prereq
condition has not been met. If a diagnostic test fails, the failure is indicated a
bottom of the Diagnostic tab. 
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In both cases, check the Alarm Monitor to determine the reason and the 
appropriate action to take. (See “Detecting, isolating, and fixing hardware 
problems” on page 87.)

To run a diagnostic test

Note: See “Starting and stopping components” on page 112 for details about 
courtesy stopping a component. Nortel Networks recommends that you cou
stop rather than stop a component if possible.

1 From the left pane of the Maintenance window, select the hardware 
component for which you want to run a diagnostic test.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 Stop the component.

4 From the right pane, click the Diagnostic tab.

Result: The Diagnostic page appears. 
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5 Select the diagnostic test you want to run.

6 Click Run.

7 View the diagnostic test results at the bottom of the Diagnostic page. 
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Viewing last diagnostic results

Introduction

If the Alarm Monitor and Event Browser do not provide a solution to a hardw
problem, a component might need to be replaced or serviced. If the problem
rests with a component that is not replaceable because it is not a physical e
(such as the timeswitch), you must replace its parent component or contact
technical support, depending on the component.

Replaceable parts are called Field Replaceable Units (FRUs). View the last
diagnostic test result in the Diagnostic tab of the Maintenance window to ob
a list of FRUs that, when replaced, will likely fix the problem.

Notes: 

1. For general information on investigating hardware problems, see 
“Detecting, isolating, and fixing hardware problems” on page 87.

2. For a description of the Diagnostic tab, see “The Diagnostics tab” on page 
104.

Field replaceable units

When you view the last results of a failed diagnostic test, a Diagnostic Resu
description appears at the bottom of the Diagnostic tab. This description 
includes a list of components that might have caused the problem. 

Each FRU is shown with a percentage that represents how probable it is th
component caused the hardware problem. Use these percentages as a gui
determine which component to try replacing first; the higher the percentage
probability, the better the chance that replacing the FRU will fix the problem
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To view the last diagnostics result 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears.

3 Click Last Result.

Result: The results of the last diagnostic test appear at the bottom of the 
Diagnostics page.

4 View the last results to determine what action to take.
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Last diagnostic results

The results of the last diagnostic test display the following information at the
bottom of the Diagnostic page: 

Information Description

Target Object This is the component selected in the tree.

Diag ID This is the ID of the diagnostic test that was run. 
The diagnostics IDs and descriptions are listed in 
the List of Diagnostics for Selected Device 
window on the Diagnostics page.

Diag result The diagnostic result includes a return code and 
whether the diagnostic test passed or failed. 

Result Description This section appears only when the diagnostic te
fails. This is a more detailed description of the 
problem. This description includes the following:

� the error that was encountered

� a list of components that might have caused the
error with a probability percentage

� troubleshooting instructions
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Obtaining replacement part numbers

Introduction

If you determine that a component needs to be replaced, contact your distrib

The Replacement tab in the Maintenance window provides component 
information. However, your distributor has the latest part number informatio
The Replacement tab is not available on all platforms.
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 Overview 124

 Diagnostics 125

 Pep Maintenance utility 128
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 Session Trace 132

 System Information 140

 System Monitor 142
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Overview

Introduction

The following table lists the CallPilot system utilities:

Accessing the System Utilities

All CallPilot customer administrator tools are accessible from the server usi
Start > Programs > CallPilot > System Utilities.

Diagnostic Enables CallPilot startup diagnostics to be 
enabled or disabled (turned on or off).

PEP Maintenance Displays a list of installed PEPs and enables PEP
uninstall.

Services Monitor Displays the true status of all CallPilot services 
according to WinNT definition.

Session Trace Provides detailed information about the activity 
in a user’s mailbox and the state of the message 
waiting indicator (MWI).

System Information Displays particulars about the CallPilot System 
such as names, keycodes, serial numbers, IP 
addresses, and system numbers.

System Monitor Displays the status of all CallPilot subsystems 
related to call processing.
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Diagnostics

Introduction

The Diagnostics startup utility is a graphical user interface that enables Call
startup diagnostics to be enabled or disabled as required by the user or the
system.

CallPilot startup diagnostics automatically identifies hardware problems tha
might exist when the system and its services are started (DSP, TimeSwitch
SCbus).

This tool saves time during system maintenance operations where restarts 
Call Processing services restarts are required.

There are three recommended steps:

� Use the Diagnostics tool to turn off CallPilot startup diagnostics.

� Perform system maintenance.

� Use the Diagnostics tool to turn on CallPilot startup diagnostics.
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To access the startup Diagnostic Tool utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Diagnostic Tool.

Result: The Diagnostics Tool window appears.
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To enable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Enable.

To disable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Disable.

Note: Nortel Networks recommends that you leave the startup diagnostics 
turned on.

When you disable CallPilot startup diagnostics; you prevent CallPilot from 
automatically identifying hardware problems that might exist when the syste
and its services are started (DSP, TimeSwitch, SCbus).
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Pep Maintenance utility

Introduction

The PEP Maintenance utility displays a list of all installed PEPs on the serv
and enables you to uninstall PEPS.

For information on uninstalling PEPs, refer to “Installing PEPs” on page 232.

To access the PEP Maintenance utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
PEP Maintenance. 

The DMI Viewer window appears.
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To view a list of all installed PEPs

1 Click the component to display the PEP list.

2 Click Show PEPs.

Result: A list of all installed PEPs appears to the right of the window.
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Services Monitor

Introduction

The Services Monitor is a graphical user interface tool that helps to determ
whether the CallPilot server is fully operational. It displays true states of the
CallPilot services according to Windows NT definition, including the states t
are not available through the control panel.

To access the Services Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Service Monitor.

Result: The ServiceMon window appears.
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Using the Services Monitor

The Services Monitor provides the status of each CallPilot service (for exam
running, any pending or pausing state).

The Refresh All button enables the display to be refreshed. Use the Set Re
Rate button to set the rate of refresh or set to none.

Note: The fact that a service is running does not necessarily mean that it is 
operational. It might require some initialization, database connections, inter
data structures, and so on.
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Session Trace

Introduction

The Session Trace tool allows you to obtain detailed information about the 
activity in a user’s mailbox and the state of the message waiting indicator 
(MWI). The session information includes

� voice messaging

� call answering

� express messaging activity (messages composed and sent, or left in a
mailbox)

� the number of messages played or unplayed at the beginning, middle, 
end of a session

� messages and personal distribution lists restored into a mailbox

� the last change to the MWI (turned on or off, or untouched)

This session information allows an administrator or technician to study the s
of a user’s mailbox and the MWI, and to use that information to follow up on
any user complaints. For example, a user might complain that the MWI was
but no voice messages were in the mailbox when the user logged on. The se
information might tell the administrator why the MWI was turned on.

To access the session trace tool

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Session Trace Tool. 

Result: The MCE Session Trace window appears.
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To find a session

1 From the Session Type drop-down menu, select the type of session.

To display a list of all session types, select All Session Types.

2 Enter as much information in the search criteria fields in the window to 
identify the session you want to view.

To display a list of all users for the selected Session Type, leave the search 
criteria fields blank.

3 Click Search to initiate the search. 

a. If you did not enter any user information, a list of users matching the 
Session Type appears on the bottom of the window.

To select a user from the list, double-click the user name to display 
session type information.

b. If you selected All Session Types for a user, the session type 
information appears to the right of the window. 

4 Double-click the session type to display the session information.

Result: The Session Type information appears on the bottom of the 
window.
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Session type information

Call Answer session type information
Part 5: 200i Server Maintenance and Diagnostics 135



System utilities  Standard 1.0
Expired messages session type information
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Express messaging session type information
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Logon session type information
138 CallPilot



May 2000 System utilities 
Selective restore session type information
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System Information

Introduction

Use this utility to view particulars about the CallPilot system, such as name
keycodes, serial numbers, IP addresses, and system numbers.

To access the System Information utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
System Information.

Result: The CallPilot System Information window appears.
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To use the System Information utility

Use this utility to view CallPilot system information at a glance.

After viewing the information on this screen, click Close to close the window
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System Monitor

Introduction

The System Monitor is a graphical user interface based tool that provides a
single point of view of CallPilot call processing status at any time. The statu
provided reflects the true internal status of the Call Processing subsystem, 
including all related call processing components. This eliminates the need to
multiple tools to get the same information.

The System Monitor queries the current status of each component it is 
monitoring and displays them in a graphical user interface. The status of ea
service is obtained from the Windows NT Service Controller; Middleware 
Components status are obtained from the CTMedia server; and the DSP an
channels status are obtained by querying Middleware. 

This tool shows the status of

� CallPilot Critical Services related to call processing

� CTMedia-based Middleware Services

� CallPilot Call Channels and Media Channels

System Monitor is a nondestructive tool that does not alter the behavior of a
CallPilot components.

Note: Users of this tool require an understanding of CallPilot and the 
components they want to monitor.
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To access the System Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
System Monitor.

Result: The CallPilot System Monitor window appears.

User interface

The user interface comprises four main areas listed below. Each area indic
the status of the particular components of the CallPilot server.

1. Services Area for Critical Windows NT-based services

2. CT Media Services Area for Middleware-based services

3. Call Channel Area for Call Arrival/Departure activities

4. Media Channel Area for DSP channel usage activities

CallPilot Critical Services
Critical Services needed for CallPilot Call Processing include

� CT Media Server Service

� Telephony Server (TAPI) Service

� MAS EMCI Service
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� MAS Notification Service

� MCE SLEE Service

� MCE Notification Service

� SQL Anywhere Service

� VBPC Load Service (useful in a DSE system)

CTMedia-based Middleware Services
Middleware resources needed for CallPilot include

� Dialogic CT Media Server Core Service

� Dialogic CT Media Server ISE Service

� Call Channel Resource Service

� Blue Call Router Service

� Media Resource Service

� Maintenance Service Provider Service

CallPilot Call Channels and Media Channels
Call and media channels needed for CallPilot include

� Multimedia Ports and Call Channel (DSP channel usage as well as Call 
Channel usage)

Online Help
To obtain a description of the various status codes for each of the window’s
components, use the online Help.

Menu items
The System Monitor tool provides several menu items for configuration:

File Closes the tool.

Refresh rate Changes the refresh rate to a desired level.

Help Displays a legend for each status symbol 
shown.
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Overview

Introduction

This chapter describes how to perform hardware maintenance and upgrade
procedures. The chapter is organized into three sections for easier referenc

Preparing for server maintenance

Section A: “Preparing for server maintenance,” on page 147, provides 
procedures usually followed whenever you must replace a component or 
perform an upgrade activity. These are the first steps in working with the se

Removing components

Section B: “Removing components,” on page 155, provides procedures 
associated with field service.

Installing and replacing card devices

Section C: “Installing and replacing card devices,” on page 171, provides 
procedures for supported PC and MPC cards. 
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Section A: Preparing for server 
maintenance

In this section
 Shutting down the server 148

 Removing the server from the switch 150

 Replacing the server 152
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Shutting down the server

Introduction

You prepare the 200i server for removal from the switch by shutting down th
software. Before you shut down the 200i server, ensure that all clients are lo
off the server.

Peripherals connected through the I/O breakout panel do not need to be 
disconnected before shutdown. The switch automatically powers the server
when the server is locked into position on an IPE shelf. The server, therefor
powers off when it is removed from the switch.

Equipment required

You need the following equipment:

� keyboard, monitor, and mouse 

or

� laptop computer

To perform a software shutdown

1 Do one of the following:

� Connect the keyboard, monitor, and mouse (or laptop) to the server, and 
then go to step 4.

� From a laptop (on the ELAN) or from a remote PC (over RAS), continue 
with step 2.

2 Start pcANYWHERE32.

3 Connect to the 200i server.

4 Log on to the server.

5 Exit all applications.

Note: For instructions on how to properly shut down a particular 
application, refer to the documentation for that application.
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6 Press the Ctrl, Alt, and Delete keys simultaneously.

Result: The Windows NT Security dialog box appears.

7 Click Shut Down... .

Result: The Shutdown Computer dialog box appears.

8 Select Shutdown.

9 Click OK.

Result: You might be informed that an SQLAnywhere service is running 
with connections, and asked if you want to end it.

10 Click Yes or End Task. 

Result: You might also be asked if you want to save ACD proxy changes.

11 Click No.

Result: The 200i server shutdown begins.

12 Wait for DOWN to appear on the System Ready Indicator LED, or for the 
message It is now safe to turn off your computer .

Note: The red LED indicator remains lit during the shutdown until you 
restart the server.
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Removing the server from the switch

Introduction

You must remove the server from the switch before replacing the following 
components:

� daughterboard

� motherboard

� hard drive

� PCB interconnect strip

� in-board PC card

� DIMM

� SCSI paddleboard

Equipment required

You need the following equipment:

� antistatic mat

� antistatic wrist strap

To remove the server from the switch

1 Shut down the server.

2 Turn off the monitor.

3 Disconnect the monitor, keyboard, and mouse. 

4 Power down the peripheral SCSI devices.

5 Disconnect the SCSI cable (if connected).

6 Open the lock latches at the top and bottom of the server.

7 Grip the faceplate and pull the server out of the IPE shelf.

8 Place the server on a clean, static-resistant surface.
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What’s next?

When you have removed the server from the switch, you can replace and 
upgrade components.
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Replacing the server

Introduction

For activities that are not supported as field procedures, you must return th
server to Nortel Networks for service. To maintain customer service, a 
replacement server must be installed on-site.

This guide covers all the procedures required to replace the 200i server.

The following steps make up the overall procedure for replacing the server.
References are made to specific component replacement procedures wher
applicable.

To replace the server

1. If the installed server is functional, then perform a full backup of the ha
disk as a precautionary measure.

2. Use the administrative client PC to take the MPC cards out of service. T
remove the MPC cards from the faceplate of the server (see page 179).

3. Shut down the installed server (see page 148).

4. Remove the server from the switch (see page 150). 

5. Disconnect all peripherals from the server. If a Network Interface card 
installed in the in-board slot, remove it and install it in the replacement 
server (see page 173). 

6. Separate the daughterboard from the motherboard, as shown on page157.

7. Remove the software feature key (dongle) from the defective server an
install it in the replacement server, as shown on page 170.

8. Remove the hard drive from the defective server and install it in the 
replacement server as shown on page 165.

9. Remove the DIMM from the defective server and install it in the 
replacement server, as shown on page 160.
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10. If a PC card was removed from the faceplate of the defective server, in
it in the replacement server.

11. Install the replacement server on the switch and connect all applicable
peripherals.

12. Install and configure any MPC cards removed from the defective serve
shown on page 178.

What’s next?
� Ensure that the 200i server is able to start up and that the Windows NT

logon window appears.

� Test the CallPilot channels as described in Part 4 of this binder.
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Section B: Removing components

In this section
 Removing the daughterboard 156

 Replacing the DIMM 160

 Replacing motherboard components 163

 Replacing the EIDE hard drive 164

 Replacing the Nortel Networks software feature key 169
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Removing the daughterboard

Introduction

The daughterboard is secured by four screws to the stiffener and the 
motherboard of the 200i server. 

Equipment required

You need the following equipment:

� antistatic wrist strap

� Phillips No. 1 screwdriver

Before you begin

Before replacing the daughterboard, review these procedures:

� “Removing the server from the switch” on page 150

� “Replacing the DIMM” on page 160
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To remove the daughterboard

1 Remove the server from the switch and lay it on a static-resistant surface, 
with the daughterboard facing up.

2 Loosen and remove the four screws, one from each corner of the 
daughterboard.

3 Put your fingers under the daughterboard on the backplane side of the 
server, and carefully lift that side of the board out of the PCB connector slot.

Note: Lift the daughterboard only slightly from the motherboard because 
the daughterboard is still secured to the hard drive data cable.
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4 Slide the daughterboard toward the backplane, freeing the VGA connector 
from the faceplate. 

5 Tilt the board to the left, and remove the hard drive data cable from the 
daughterboard.Take note of the pin 1 location (red pin stripe) of the hard 
drive data cable for later reconnection.

6 Set the board down with the component side facing up.

To replace the daughterboard components

1 Unpack the replacement daughterboard, and set it component-side up near 
the defective board.

2 Remove the PCB interconnect board from its slot on the defective 
daughterboard.

Note: If the PCB interconnect board is not attached to the defective 
daughterboard, then it might have detached from the daughterboard when 
the daughterboard was removed from the 200i server. In this case, the PCB 
interconnect board might still be attached to the motherboard. 

3 Install the PCB interconnect board on the replacement daughterboard.

4 Remove the DIMM from the defective daughterboard, as described in the 
procedure on page 160. 

5 Install the DIMM on the replacement daughterboard.

6 Attach the hard drive data cable connector to the replacement 
daughterboard.
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7 Insert the replacement daughterboard into the stiffener so that the VGA 
connector sits out of the faceplate.

8 On the backplane side of the board, align the PCB interconnect board with 
its slot on the motherboard.

9 Apply downward pressure evenly across the connector until it is securely 
seated.

10 Insert and tighten the four screws removed in step 2 on page 157 into each 
corner of the replacement board. 

What’s next?

Review the procedures for installing the server and conducting diagnostic te

ATTENTION Ensure that the hard drive DC power connector and 40-
pin ribbon connector are not pinched when inserting the 
daughterboard.
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Replacing the DIMM

Introduction

The DIMM resides in a slot on the daughterboard and is secured by a lock l
The lock latch rotates freely to an open position so the DIMM can be remov
and closes to secure the DIMM in the proper position.

The DIMM is keyed so that it can only be fully seated and secured by the lo
latch when it is inserted correctly.

Equipment required

You need the following equipment:

� antistatic wrist strap

� Phillips No. 1 screwdriver

Before you begin

Perform the following tasks to replace the DIMM:

� “Removing the server from the switch” on page 150

� “Removing the daughterboard” on page 156

To replace the DIMM

1 Remove the daughterboard from the motherboard and stiffener, as shown 
on page 157. 

2 Set the daughterboard on an antistatic surface with the component side 
facing up.
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3 Move the lock latch to its open position.

4 Slide the DIMM out of its slot until it clears the slot socket. Then lift out the 
DIMM.

Note: You might need to use a slot-head screwdriver to extract the non-
lock-latch side of the DIMM from the socket.

Open the 
lock latch

The slot that holds the memory module in place
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5 Push the DIMM into the slot on the replacement server. 

Result: The lock latch snaps into place when the DIMM is inserted 
completely.

Note: The DIMM is keyed to line up with the DIMM socket (the socket has 
blanks that line up with the notches on the DIMM). If the DIMM is inserted 
upside-down, then the lock latch will not close.

What’s next?

Review the procedures for installing the server and conducting diagnostic te
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Replacing motherboard components

Introduction

The faceplate and stiffener of the 200i server are attached to the motherboa
When you replace the motherboard, the faceplate and stiffener are also rep
as one unit. 

Equipment required

You need the following equipment:

� antistatic wrist strap

� Phillips No. 1 screwdriver

� slot-head screwdriver

Before you begin

Remove the server from the switch and lay it on a static-resistant surface, w
the daughterboard facing up. 

To replace the motherboard components

Remove each of the following components from the defective motherboard 
install them in the replacement server:

� EIDE hard drive (see page 164)

� software feature key (see page 169)

� faceplate-accessible flash card (see page 172)

� in-board network interface card (see page 173)

� MPC-8 cards (see page 176)

What’s next?

Review the procedures for installing the server and conducting diagnostic te
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Replacing the EIDE hard drive

Introduction

The hard drive is positioned beside the daughterboard and rests lengthwise 
the backplane side of the server. Four screws secure the hard drive in place
on the backplane edge of the stiffener, one through the motherboard, and o
through the bottom edge of the stiffener.

 Equipment required

You need the following equipment:

� antistatic wrist strap

� Phillips No. 1 screwdriver

� slotted screwdriver

Before you begin

Before you replace the hard drive on a new 200i server, review “Removing the 
server from the switch” on page 150. 
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To remove the EIDE hard drive

1 Loosen and remove the following four screws:

� one screw on the bottom of the motherboard stiffener

Note: On some versions of the 200i server, the SCSI cable is routed 
around the outside edge of the stiffener. In this situation, lift the SCSI cable 
over the top of the stiffener so that you can access the screws that secure 
the hard drive.

� two screws on the side of the motherboard stiffener

The second screw 
is behind the 
ribbon cable.

First screw
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� one screw underneath the motherboard

. 

CAUTION

Risk of damage to the hard drive
Hold on to the hard drive with one hand as you remove this last 
screw.
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2 Push the hard drive slightly toward the daughterboard so that the hard drive 
is free of the bottom edge of the motherboard stiffener.

3 Lift the hard drive out of the stiffener, and disconnect the hard drive power 
and data cables.

4 Verify with the manufacturer’s documentation that the jumpers are set 
correctly. 

Note: The drive must be configured as the primary drive.

5 Position the drive in the new server.

Power 
cable

Red 
stripe

Data 
cable

Red 
stripe
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6 Attach the hard drive power and data cables.

Note: Ensure that the red stripe on the data cable is next to the red stripe 
on the power cable.

7 Angle the drive slightly downward and toward the daughterboard until you 
can lower the replacement drive into the motherboard stiffener.

8 Align the drive with the screw holes, and tighten the screws.

What’s next?

Review the procedures for installing the server and conducting diagnostic te
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Replacing the Nortel Networks software 
feature key

Introduction

The software feature key is a software security device (sometimes called a 
dongle). This key stores the unique serial number of the server.

Equipment required

You need the following equipment:

� Phillips No. 1 screwdriver

� tweezers

Before you begin

Review “Removing the daughterboard” on page 156.
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To replace the software feature key

1 Remove the daughterboard from the motherboard.

2 Pull the software feature key out from under the clip. 

Note: Apply a slight upward pressure on the clip, but ensure the clip is not 
strained to such a degree that it can no longer apply enough downward 
pressure to hold the new software feature key in place.

3 Insert the software feature key into the socket on the replacement 
motherboard, lip-side up.

4 Reattach the daughterboard to the motherboard.

Software 
feature 
key
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Section C: Installing and replacing card 
devices

In this section
 About PC cards 172

 Network interface cards 173

 Nortel Networks Multimedia Processing Cards 176
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About PC cards

Introduction

PC cards are small, versatile devices used on the 200i server. PC cards are
the same size as credit cards, but thicker.

Supported PC cards

PC cards supported on the 200i server include an Ethernet interface, a Tok
Ring interface, and a Nortel Networks-issued flash card used for system 
recovery. Check with your Nortel Networks representative for the most rece
list of supported PC card types.
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Network interface cards

Introduction

Network interface cards allow you to connect your 200i server to an existing
network (CLAN) for connectivity to desktop computers or for LAN-based 
server administration.

The 200i has an internal slot on the motherboard where a single network ca
can be added. The network card can be an Ethernet interface card or a Tok
Ring interface card.

To install a network interface card

1 Remove the hard drive as described on page 165.

2 Insert the PC card into the internal PC card slot, label-side up.

Note: The following picture shows a correctly inserted Ethernet card:

3 Remove the jumper block from the motherboard stiffener.

PC card
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4 Thread the pigtail end of the card cable under the motherboard stiffener.

5 Connect the card cable jumper block to the pin header.

Note: The pin header is located to the right of the motherboard stiffener.

6 Connect the other end of the cable to the PC card.

Note: Bend the cable so that it can be connected to the PC card and it lies 
flat.

Result: The following picture shows a connected Ethernet card:

Pigtail end of 
NIC cable

Motherboard 
stiffener

PC card 
connector
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The following picture shows a connected Token Ring card:

7 Replace the hard drive.

Note: You must also add and configure the correct driver software.
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Nortel Networks Multimedia Processing Cards

Introduction

The Nortel Networks MPC-8 card supports multimedia telephony services o
the 200i server. Two specially designed card slots are available for the MPC
Both are located on the 200i server faceplate.

Note: The MPC-8 card looks like a Type II PC card, but it uses different 
technology and is not compatible with standard PC card slots. 

. 

CAUTION

Risk of equipment damage
Any attempt to install an MPC card into a standard PC ca
slot results in equipment damage.
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Correct card insertion

The MPC-8 card is keyed so that it fits only one way into the slot on the 200
server faceplate. If the card is inserted incorrectly, the card does not go all t
way into the slot.

MPC card slot LEDs

There is an LED for each MPC card slot. The following picture shows where
these slots and LEDs are located on the 200i server:

. 

CAUTION

Risk of equipment damage
If you force the card into the slot incorrectly, this can resu
in damage to the MPC-8 card and the 200i server.

Two MPC slots
(for MPC cards only)

MPC slot LEDs
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The following table describes each LED status:

To add an MPC-8 card

1 Ensure that the MPC-8 card label is facing one of the following ways:

� facing to the right if the 200i server is inserted into the IPE shelf (see the 
picture below)

� facing up if the faceplate is lying horizontally on a flat surface

Status Description

Off The MPC card is not receiving power. It is safe to remove t
card.

On The MPC card is in use. In this case, it is not safe to remove 
the card.

Off, then on The MPC card has been recognized by the 200i server 
software and has been powered up.

On, then off The MPC card has been successfully powered down. It i
safe to remove the card.
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2 Insert the card into the slot, and gently push it until it is firmly in place and 
the ejector button pops back out.

3 Configure the client application so that it recognizes the MPC and its 
channels.

Note: You might need a new keycode to use the new card.

4 Enable the card and its channels.

Note: For instructions on configuring and enabling the MPC-8 card and its 
channels, refer to the documentation for your client application.

To replace MPC cards

Note: An MPC-8 card can be replaced on a 200i server without powering do
the server. This procedure assumes that the 200i server is locked into positi
the IPE shelf. If it is not, perform steps 7 to 10 only.

1 On the Administrative client PC, log on to the CallPilot system.

2 Open the CallPilot Administration Client window, and click System 
Administration > Maintenance Administration > Maintenance.

3 From the left pane of the Maintenance window, select the MPC-8 card you 
need to replace. 

Result: The General page appears.
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4 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

5 Click Courtesy stop or Stop. 

Result: The MPC-8 card changes to an Off Duty state.

6 Click Power Down.

Result: The MPC-8 card is powered off.

7 Ensure that the MPC’s LED on the 200i server faceplate is not lit, which 
indicates that the MPC is no longer receiving power.

. e

CAUTION

Risk of equipment damage
If you remove an MPC while it is receiving power, this can
damage the MPC or the 200i server.
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8 Press the MPC’s ejector button to dislodge the MPC from its slot. The 
ejector button is on the 200i faceplate underneath the MPC slot. There is 
one ejector button for each MPC slot.

9 Pull the MPC out of its slot.

10 Insert the new MPC into the slot, and gently push it until it is firmly in place 
and the ejector button pops back out.

11 Ensure that the MPC’s LED lights up green.

12 Ensure that the new MPC-8 card is highlighted in the left pane of the 
Maintenance window.

13 In the Maintenance window, click Power Up.

14 In the Maintenance window, click Start.

Result: The MPC-8 card changes to an Idle state and is now operational.
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C h a p t e r  6

Installing the operating system and 
server software (for recovery 
purposes)

In this chapter
 Overview 184

 Preparing configuration information for Windows NT 188

 Configuring the server’s system BIOS 190

 Installing and configuring MS-DOS 191

 Preparing drivers required for Windows NT 4.0 installation 193

 Preparing to install Windows NT from the LAN 194

 Preparing to install Windows NT from the CD-ROM 196

 Installing Windows NT Server 4.0 198

 Completing the system build 214

 Installing service packs 216

 Installing the updated SCSI driver 220

 Installing pcANYWHERE32 on the 200i server 221

 Installing CallPilot server software 227

 Installing PEPs 232
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Overview

Introduction

This section describes how to install the software that is preinstalled on the
CallPilot server at the factory. Most of the procedures described here are 
typically required only in a recovery situation. See Chapter 11, “Recovering 
from a hard drive failure or corrupted software,” for additional information on 
hard disk recovery.

Windows NT configuration information worksheet

See “Preparing configuration information for Windows NT” on page 188.

What this chapter contains

This chapter explains how to do the following:

� Configure the server’s system BIOS.

� Install and configure MS-DOS.

� Prepare to install Windows NT from the LAN or CD-ROM.

� Install Windows NT Server 4.0.

� Do the following to complete the system build:

� Reenable Console Redirection.

� Clean up the MS-DOS partition.

� Install the tape drive driver.

� Install service packs.

� Install pcANYWHERE32.

� Install CallPilot server software.

� Install Performance Enhancement Packages (PEPs).
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Hardware requirements

You need the following items to perform a hard disk recovery and build:

� flash recovery PC card

� local CD-ROM drive (if not installing from the LAN)

� appropriate cabling (CD-ROM drive or LAN access)

� Operating System CD-ROM 

� CallPilot Server CD

� PEP CD

Configure the server’s system BIOS

Before you can install the operating system and application software, you m
properly configure the 200i server system BIOS. This involves setting the 
system time and date, and ensuring that Console Redirect Port is disabled.

Install and configure MS-DOS

The next step in performing a hard disk recovery is to install MS-DOS. To ins
MS-DOS, you use an automated series of scripts (batch files) that partition 
hard disk and load MS-DOS. After diagnostics have completed and all hardw
is verified as sane, follow the procedure to install MS-DOS.

Prepare to install Windows NT from the LAN or CD-ROM

If the Windows NT software is being stored on a server on your LAN, you c
choose to install Windows NT from there; or, if you have the Operating Syst
CD-ROM, you can use it to install Windows NT.

Install Windows NT Server 4.0

Windows NT Server 4.0 is the operating system on which the 200i server 
software runs. 
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The procedure for installing Windows NT is divided into smaller procedures
that you can preview, in advance, the type of information you need to enter.
must complete the stages in sequence. If you choose to exit from the install
at any stage, you must cancel the Windows NT installation and begin again

Ensure that you have the following information before you start:

� administrator’s password

� time zone

� ELAN IP address and subnet mask

� CLAN IP address, subnet mask, and default gateway IP address (if a C
NIC is installed)

� range of remote access server (RAS) IP addresses

� country and area code

� computer name

� workgroup name

Complete the system build

The following tasks complete the system build:

� Reenable Console Redirection.

� Remove any temporary files that were created on the MS-DOS partitio

� Install the tape drive driver.

Install service packs

A service pack is an update provided by Microsoft for Windows operating 
systems. Service packs provide new versions of files and fixes for problems
have been reported. 

Install pcANYWHERE32

pcANYWHERE32 enables your distributor or Nortel Networks support to dia
in to the server to provide product support.
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Install CallPilot server software

Once you have completed installing the operating system, you can install th
CallPilot server software. 

Install Performance Enhancement Packages

Performance Enhancement Packages (PEPs) are provided on CD-ROM. Yo
must install PEPs in a specific order as identified in the readme files on the 
CD-ROM. 
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Preparing configuration information for 
Windows NT

Configuration information

Use the following table to record data that you need to enter during the 
installation of Windows NT. You should consult with the company’s Network
Administrator to obtain the values for the items listed in the table.

Item
Information from company’s 
Network Administrator

Name

Company Name

Computer Name

Administrative account password

Remote Access

Begin

End

From

To

Excluded

Network - IP Address

IP Address

Subnet Mask

Default Gateway
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Network - DNS

Host Name (= Computer Name)

Domain

DNS Service Search Order

Domain Suffix Search Order

Network - WINS

Primary WINS Server

Secondary WINS Server

Item
Information from company’s 
Network Administrator
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Configuring the server’s system BIOS

Introduction

Before you can install the operating system and application software, you m
properly configure the 200i server system BIOS. This involves setting the 
system time and date, and ensuring that Console Redirect Port is disabled.

Note: After you install Windows NT, the BIOS settings are restored to their 
original values.

To set up the system BIOS

1 Attach a CD-ROM drive, keyboard, mouse, and monitor to the faceplate.

2 Press the reset button on the 200i server faceplate to reboot the server.

3 When the Press <F2> to enter Setup, <ALT> to bypass PC 
Card Boot  prompt appears, press F2. 

4 With the arrow and tab keys, select Main.

5 Enter the correct system time and date.

6 Select Server.

7 Ensure that Console Redirect Port is disabled.

8 Use the arrow keys to select Exit MENU.

9 Select Save Changes and Exit, and then press Enter.

10 Select Continue.

Result: The system reboots with the settings required to allow installation 
of Windows NT.

11 Install MS-DOS.

Note: For instructions, see “Installing and configuring MS-DOS” on page 
191.
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Installing and configuring MS-DOS

Introduction

The next step in performing a hard disk recovery is to install MS-DOS. To ins
MS-DOS, you use an automated series of scripts (batch files) that partition 
hard disk and load MS-DOS. After diagnostics are completed and all hardw
is verified as sane, follow this procedure to install MS-DOS.

You use the flash recovery PC card to install MS-DOS 6.20 on the 200i serv

To install MS-DOS

1 Ensure the flash recovery PC card is inserted into its socket on the 200i 
server faceplate.

2 Press the reset button to reboot the server.

Result: The following menu appears:

A Erase the hard drive

B Phase 1 DOS Install

C Phase 2 DOS Install

D Run Diagnostics

X Exit to DOS

3 Press A to remove all existing partitions from the disk.

Result: The server reboots after the disk cleanup, and the same menu 
appears.

4 Press B to partition the drive. 

Result: The system creates the appropriate partition to install DOS. When 
completed, the server reboots and the same menu appears.

ATTENTION This procedure erases all data on the hard drive.

Do not enable the MS-DOS DoubleSpace disk compression
feature.
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5 Press C. 

Result: MS-DOS and some IPE installation-specific files load to the C:\ 
drive (a 150 Mbyte FAT partition). MS-DOS setup is complete. 

6 Press the PC card socket’s ejector button to eject the card.

7 Remove the PC card from the socket.

8 Press Ctrl-Alt-Delete. 

Result: The server boots from the MS-DOS partition and displays the 
following menu:

A: LAN install

B: Local CD-ROM install

C: Load PCMCIA support

D: Load diagnostics

9 Install Windows NT with one of the following:

� information needed for connecting to the server where the Windows NT 
installation package is stored (see “Preparing to install Windows NT 
from the LAN” on page 194)

� Operating System CD-ROM (see “Preparing to install Windows NT from 
the CD-ROM” on page 196)
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Preparing drivers required for Windows NT 4.0 
installation

Introduction

All drivers are contained on the Application Server Master Driver CD. This 
procedure copies all the required drivers to the hard drive in the directory 
C:\200tmp. The drivers are grouped in subfolders in C:\200tmp. When prom
for a driver during the Windows NT installation, go to C:\200tmp to locate th
driver you need.

To copy drivers onto the hard drive

1 Insert the Application Server Driver CD into the CD-ROM drive.

2 Double-click My Computer. Then double-click the CD-ROM icon. 

3 Open the 200i folder on the Application Server Master Driver CD.

4 Double-click setup.bat.

Result: All the drivers are loaded onto the hard drive in the directory 
C:\200tmp. 

5 Close the setup window.

6 Remove the Application Server Master Driver CD.
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Preparing to install Windows NT from the LAN

Introduction

This procedure explains how to prepare for Windows NT installation from a 
temporary PC on the ELAN instead of from the Operating System CD-ROM

Before you begin

Before you can install Windows NT, you must reinstall MS-DOS and reboot 
server as described in “Installing and configuring MS-DOS” on page 191. Once 
completed, the following menu appears:

A: LAN install

B: Local CD-ROM install

C: Load PCMCIA support

D: Load diagnostics

To install Windows NT from the LAN

1 Ensure that the I/O breakout panel is connected and cabled properly.

2 From the menu, press A.

Result: The server reboots with ELAN Network card support. 

3 When prompted, enter the network information needed to connect to the 
server containing the Windows NT installation files. 

4 Modify the appropriate values for your location, and press 0 to exit.

Result: The LAN-based setup launches.

Note: If an error occurs while loading the LAN drivers or connecting to the 
remote PC, then error messages appear on the console. The installation 

ATTENTION If an error occurs during the installation (for example, a 
LAN cable is accidentally removed, or power is lost), eras
the hard disk and reinstall MS-DOS and Windows NT.
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stops at the command prompt. Ensure that the LAN cabling and ELAN 
parameters (that is, computer name, IP address, and so on) are correct.

Restart the installation by rebooting the server and selecting A: LAN install 
from the menu.

5 If you are prompted to enter a user ID and password, enter them.

Result: Some setup files are copied to the hard disk, and you are prompted 
to reboot. 

6 Instead of rebooting, continue with the installation as described in 
“Installing Windows NT Server 4.0” on page 198. 
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Preparing to install Windows NT from the 
CD-ROM

Introduction

If you have the Operating System CD-ROM, you can use it to install Window
NT.

Before you begin

Your CD-ROM drive must be connected before the server is powered on. If 
CD-ROM is not connected, do the following:

1. Power off the 200i server.

2. Attach the CD-ROM drive.

3. Power up the CD-ROM drive.

4. Power on the 200i server.

Before you can install Windows NT, you must reinstall MS-DOS and reboot
server as described in “Installing and configuring MS-DOS” on page 191. Once 
completed, the following menu appears:

A: LAN install

B: Local CD-ROM install

C: Load PCMCIA support

D: Load diagnostics

ATTENTION If an error occurs during the installation (for example, a 
SCSI cable is accidentally removed, or power is lost), era
the hard disk, and reinstall MS-DOS and Windows NT.
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To install Windows NT from the CD-ROM

1 From the menu, select B.

Result: Some setup files copy to the hard disk, and the server reboots. The 
generic SCSI CD-ROM driver loads, and you are prompted to insert the 
Operating System CD-ROM into the CD-ROM drive. 

2 Insert the Operating System CD-ROM into the CD-ROM drive.

3 Press any key to continue with the installation. 

Result: A delay of approximately 15 seconds occurs to allow the CD-ROM 
to spin up and start the installation. Files automatically copy to the system, 
and you are prompted to reboot.

Note: If the CD-ROM drive is not ready, you receive a Not ready 
reading drive  message. Ensure that the correct CD-ROM is in the drive 
and that the SCSI cable is connected and powered on. Press R to retry the 
operation. If the installation fails repeatedly, power off the server, examine 
all of the connections, and retry the installation.

4 Press Enter to restart the 200i server.

Result: The 200i server restarts, and the Windows NT setup screen 
appears.

5 Continue with the installation as described in “Installing Windows NT 
Server 4.0” on page 198. 
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Installing Windows NT Server 4.0

Introduction

This section explains how to install Windows NT Server 4.0. For clarification
this section divides the entire installation procedure into the following 
procedures so that you can preview, in advance, the type of information you 
to enter:

1. Begin installation, and then confirm drivers and devices.

2. Format the hard drive.

3. Configure with the Windows NT Setup Wizard.

4. Begin configuration of the server for network use.

5. Configure network card drivers.

6. Add network protocols and services.

7. Configure the Etherlink III or Token Ring card settings.

8. Configure network services.

9. Configure network addresses.

10. Configure the date and time.

11. Configure the display adapter.

12. Finish the installation.

You must complete the installation in sequence. If you choose to exit from t
installation at any stage, you cancel the Windows NT installation and must b
again.

Before you begin

Before you can install Windows NT, review this section and ensure that you h
all the information you need to complete the installation.

Then perform one of the following procedures:
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� “Preparing to install Windows NT from the LAN” on page 194

� “Preparing to install Windows NT from the CD-ROM” on page 196

To begin installation and confirm drivers and devices

1 At the Windows NT Setup screen, press Enter to continue setup.

Result: You are prompted to select the mass storage controllers.

The following items should both be listed:

� IDE CD-ROM (ATAPI 1.2)/PCI IDE Controller

� Symbios Logic C810 PCI SCSI Host Adapter

2 Press Enter.

Result: The licensing agreement appears.

3 Scroll down to the end of the text, and then press F8 to agree with the 
licensing agreement.

Result: A list of installed hardware devices appears.

4 Review the list, and then select “The above list matches my computer” and 
press Enter. 

Note: A list of devices that does not match what is actually installed can 
indicate a hardware problem.

Result: The Windows NT disk partitioning screen appears.

5 Continue with “To format the hard drive” on page 200.

IF there is no THEN

IDE driver there is a hardware problem. Contact your Nortel 
Networks support representative.

SCSI driver the SCSI paddleboard is not installed.

Install the SCSI paddleboard, and retry the Windows 
NT installation. 

If there is still no SCSI driver, contact your Nortel 
Networks support representative.
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To format the hard drive

1 Do the following:

2 Use the arrow keys to select Format the partition using the NTFS file 
system, and press Enter.

Result: The new partition is formatted, and you are prompted for the 
installation path.

For Do the following

2 Gbyte primary 
disks

Select Unpartitioned space on the primary hard disk, 
(Disk 0) and press Enter.

Result:  You are prompted to select the format type 
NTFS or FAT.

4 Gbyte primary 
disks

If the unpartitioned space on the primary hard disk 
(Disk 0) is larger than 4096 Mbytes, select 
Unpartitioned space and press C to create a partition. 
Enter 4096 Mbytes as the size. Select the partition you 
just created, and press Enter.

If the unpartitioned space on the primary hard disk 
(Disk 0) is less than 4096 Mbytes, select Unpartitioned 
space on the primary hard disk (Disk 0) and press 
Enter.

Result:  You are prompted to select the format type 
NTFS or FAT.

9 Gbyte primary 
disks

� Select Unpartitioned space on the primary hard 
disk (Disk 0), and press C to create a partition. 

� Enter 4096 Mbytes as the size.
Note:  The remaining space should be less than 
4096 Mbytes. 

� Select the remaining unpartitioned space on the 
primary disk, and press C. 

� Enter 4096 Mbytes or accept the default size, 
whichever is lower. 

� Select the first partition you created, and press 
Enter.

Result:  You are prompted to select the format type 
NTFS or FAT.
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Note: The time it takes to format the hard drive depends on the drive size 
and type.

3 Press Enter to select the default directory for installing Windows NT. 

Note: The default directory is \winnt.

Result: You are prompted to perform a comprehensive disk check.

4 Press Enter.

Result: When the disk check is complete, you are prompted to reboot.

5 Press Enter to reboot the server and launch the graphical portion of the 
Windows NT setup.

Result: Now that the text-mode portion of Windows NT Setup is complete, 
the system reboots and converts the newly formatted partition from the FAT 
file system to the NTFS file system. The system reboots when the file 
system conversion is complete and launches the graphical portion of 
Windows NT setup. 

6 Continue with “To configure with the Windows NT Setup Wizard” below.

To configure with the Windows NT Setup Wizard

1 On the Windows NT Setup screen, click Next to continue.

Result: You are prompted for the name and organization.

2 Enter the data requested and click Next. 

Result: You are prompted for the product ID.

3 Enter the product ID and click Next.

Result: You are prompted to choose the Windows NT licensing mode.

4 Under the licensing mode screen, select Per server and specify 5 as the 
number of concurrent connections. Then click Next.

Result: You are prompted to enter the computer name.

5 Enter the computer name and click Next.

Note: Obtain this information from the network administrator. Enter only 
alphanumeric characters (a–z and 0–9).

Result: You are prompted to select the computer’s role.
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6 Under Server type, select Stand-Alone Server and click Next.

Result: You are prompted to enter the administrator account password.

7 Enter the administrator account password and the confirmation password, 
and then click Next.

Note: Obtain this information from your network administrator. The 
passwords are case-sensitive. 

Result: You are prompted to create an emergency repair disk.

8 Select No, Do not create an emergency repair disk, and then click Next.

Note: An emergency repair disk cannot be created or used on the 200i 
server since the 200i server does not have a floppy drive.

Result: You are prompted to select the optional Windows components to 
install.

9 Ensure the check boxes are in the following states:

10 Uncheck any options not listed in step 9 that are checked.

Result: You are prompted to begin the setup of Windows NT networking.

11 Click Next.

Result: You are prompted to select how Windows NT participates on the 
network.

Component State

Accessibility Options Unchecked

Accessories Checked

WordPad Checked (select Accessories, and then click 
Details to choose this option)

Communications Checked

HyperTerminal Checked (select Communications, and then 
click Details to choose this option)

Games Unchecked

Multimedia Unchecked

Windows Messaging Unchecked
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12 Continue with “To begin configuration of the server for network use” below.

To begin configuration of the server for network use

1 Select the option This computer will participate on a network.

2 Ensure the check boxes are in the following states:

3 Click Next to continue.

Result: You are prompted to install Internet Information Server.

4 Deselect the Install Microsoft Internet Information Server option by clearing 
the check box, and then click Next.

Result: You are prompted to install the network card drivers.

5 Continue with “To configure network interface card drivers” below.

To configure network interface card drivers

Note: Ensure that the ELAN driver is installed before the CLAN driver.

1 To choose the ELAN driver to install, click Select from list.

Result: Windows NT displays the list of available network drivers.

2 Click Have Disk to specify a location to find the driver.

Result: Windows NT displays the Insert Disk dialog box.

3 Type the path c:\200tmp\network\pcnet\oemsetup.inf  and click OK.

4 When prompted to select a driver, choose AMD PCNET Family Ethernet 
Adapter, and then click OK.

5 To choose the CLAN driver to install, click Select from list.

Result: Windows NT displays a list of available network drivers.

6 Click Have Disk to specify a location to find a driver.

Result: Windows NT displays the Insert Disk dialog box.

Network behavior State

Wired to the network Checked

Remote access to the network Unchecked
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7 Do the following:

Result: You are prompted to select the network protocols to install.

8 Continue with “To add network protocols and services” on page 205.

IF the system has THEN do the following

a 3Com EtherLink 
Ethernet CLAN card

� Type the path 
c:\200tmp\network\etherlnk\oemsetup.inf  
and click OK.

� When prompted to select a driver, choose 
3Com EtherLink III (3C589D) LAN PC Card 
and click OK. Then click Next.

a 3Com LAN Megahertz 
Ethernet CLAN card

� Type the path 
c:\200tmp\network\megahz\disk1\oemset
up.inf  and click OK.

� When prompted to select a driver, choose the 
driver for 3Com LAN Megahertz PC Card and 
click OK. Then click Next.

a Token Ring CLAN card � Type the path 
c:\200tmp\network\tokenlnk\disk2\nt\oem
setup.inf  and click OK.

� When prompted to select a driver, choose 
3ComTokenLink Velocity PC Card and click 
OK. Then click Next.
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To add network protocols and services

1 Ensure the check boxes are in the following states:

2 Click Next. 

Result: You are prompted to select the network services to install.

3 From the Network Services screen, click Select from list.

Result: A list of network services appears.

4 Select SNMP Service and click OK.

5 Repeat step 4 to select the following services, and then click OK:

� Microsoft TCP/IP Printing

� Remote Access Service

Result: You return to the Network Services screen.

6 Click Next to continue. 

Result: You are prompted to confirm the installation of the network 
components.

7 Click Next to confirm and install the selected networking components.

Result: Files are copied to the system. You might be prompted with a 
dialog box indicating the network card settings.

8 Continue with one of the following procedures: 

� “To configure the 3Com Etherlink III or 3Com LAN Megahertz card 
settings” on page 206

� “To configure the TokenLink Velocity card settings” on page 206

Network protocol State

TCP/IP Protocol Checked

NWLink IPX/SPX Compatible 
Transport

Unchecked

NetBEUI Protocol Unchecked
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To configure the 3Com Etherlink III or 3Com LAN Megahertz card 
settings

1 In the 3Com EtherLink III PC Card or 3Com LAN Megahertz PC Card 
dialog box, set the I/O Port Address to 0x300. 

2 Set the interrupt number to 9.

3 Click Continue. 

4 Set the type to PCMCIA and the number to 0.

5 Click OK.

Result: The Setup Message dialog box appears. 

6 Click OK to accept that the network card parameters are not verifiably 
correct.

Result: You are presented with the option to use DHCP to configure the 
network.

7 Continue with “To configure network services” on page 207.

To configure the TokenLink Velocity card settings

1 In the 3ComTokenLink Velocity PC Card dialog box, select 3COM 
TokenLink Velocity PC Card.

2 Click Configure.

Result: The Select Operating Mode dialog box appears.

3 Ensure Compatible Mode is selected and click OK.

Result: The Compatible Mode Settings dialog box appears.

4 Accept the defaults and click OK. 

Result: You return to the 3ComTokenLink Velocity PC Card dialog box.

5 Click Save.

Result: You are presented with the option to use DHCP to configure the 
network.

6 Continue with “To configure network services.”
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To configure network services

1 Click NO to using DHCP.

Result: You are prompted to configure the SNMP service. 

Note: Since the SNMP service is added only to provide additional 
Performance Monitor counters, no configuration is necessary.

2 Click OK to accept the default SNMP Configuration and continue.

Result: You are prompted to configure the Remote Access Service.

3 Click Yes to invoke the modem installer.

Result: You are prompted to install a modem.

4 Select Don’t detect my modem; I will select it from a list, and then click 
Next.

5 Scroll through the list and select your modem as follows, and then click 
Next:

� Manufacturer: US Robotics, Inc.

� Model: Sportster 28800-33600 External

Result: You are prompted for the port to be used.

6 Select COM1 as the port and click Next.

Result: You are prompted for the country and area code.

7 Enter your area code and click Next.

8 Select Tone or Pulse dialing.

9 Complete the prompt “If you dial a number to access an outside line, what 
is it?” by entering the appropriate outgoing line access code, and then click 
Next.

Result: You are informed that the modem has been set up successfully.

10 Click Finish.

Result: The Add RAS Device window appears.

11 In the Add RAS Device window, click OK.

Result: The Remote Access Setup window appears.

12 In the Remote Access Setup window, click Configure.

Result: The Configure Port Usage window appears.
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13 Ensure Receive calls only is selected, and then click OK.

Result: The Remote Access Setup window reappears.

14 Click Network.

Result: You are prompted for the network configuration.

15 Continue with “To configure the network addresses.”

To configure the network addresses

1 Ensure the check boxes are in the following states:

2 Next to the TCP/IP check box, click Configure.

Result: The RAS Server TCP/IP Configuration window appears.

3 Under Allow remote TCP/IP clients to access, select the following:

� This computer only

� Use Static address pool

4 In the Begin and End boxes, type the first and last IP addresses of the IP 
address pool to be used.

5 Ensure that Allow remote clients to request a predetermined IP address is 
unchecked.

6 Click OK.

Result: The Network Configuration window reappears.

Network setting State

NetBEUI Unchecked

TCP/IP Checked

IPX Unchecked

Require Microsoft encrypted 
authentication

Checked

Require data encryption Unchecked

Enable Multilink Unchecked
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7 Click OK.

Result: The Remote Access Setup window reappears.

8 Click Continue.

Result: Files are copied to the system. When completed, you are prompted 
to enter the TCP/IP configuration parameters.

9 In the Microsoft TCP/IP Properties window, select the ELAN card (AMD 
PCNET Family Ethernet).

10 Ensure that Specify an IP address is checked.

11 Enter the following:

� IP address

� subnet mask

� default gateway

12 Click OK. 

13 If one is installed, select the CLAN (3Com Etherlink III or 3Com LAN 
Megahertz) or Token Ring (3Com TokenLink Velocity) card.

14 Ensure that Specify an IP address is checked.

15 Enter the following information for the CLAN or Token Ring card:

� IP address

� subnet mask

� default gateway

16 Click OK.

Result: You are asked At least one of the adapter cards has 
an empty primary WINS address. Do you want to continue?

17 Click Yes.

18 Enter the IP address for the WINS server.

Result: You are prompted to adjust the binding order of the network 
services.

19 In the Show Binding for list, select all Services.

20 Configure NetBIOS binding as follows:
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a. Expand the NetBIOS service group by clicking + beside NetBIOS 
Interface.

b. Expand the WINS client (TCP/IP) group by clicking +.

c. Click AMD PCNET PCI Ethernet Adapter, and then click Move Up or 
Move Down to position it at the top of the list.

d. Click 3Com Etherlink III (3C589D), 3Com LAN Megahertz, or 
3ComTokenLink Velocity, and then click Move Up or Move Down to 
position the adapter after AMD PCNET PCI Ethernet Adapter.

21 Repeat step 20 for server and workstation bindings.

22 Configure Remote Access Server bindings as follows:

a. Expand the Remote Access Service group by clicking + beside 
NetBIOS Interface.

b. Expand the WINS client (TCP/IP) group by clicking +.

c. Click Remote Access WAN Wrapper, and then click Move Up or Move 
Down to position it at the top of the list.

d. Click AMD PCNET PCI Ethernet Adapter, and then click Move Up or 
Move Down to position it after Remote Access WAN Wrapper.

e. Click 3Com Etherlink III (3C589D), 3Com LAN Megahertz, or 
3ComTokenLink Velocity, and then click Move Up or Move Down to 
position the adapter after AMD PCNET PCI Ethernet Adapter.

23 Click Next.

Note: If, at a later time, you add or replace the CLAN or Token Ring 
adapter, you must readjust the binding order.

Result: You are prompted to start the network.

24 Click Next.

Result: Windows NT starts the network, and you are prompted to enter 
domain or workgroup settings.

Note: You might receive the following message:

The system has detected an IP address conflict with 
another system on the network. The local interface has 
been disabled. More details are available in the system 
event log. Consult your network administrator to 
resolve the conflict.
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If you receive this message, then either one or both of the IP addresses you 
entered for the ELAN or CLAN NICs are not unique. You must enter unique 
IP addresses.

25 Enter the workgroup name, and then click Next.

Result: Windows NT prepares to complete setup. 

26 Click Finish to complete the Windows NT Networking setup.

Result: You are prompted for date and time configuration settings.

27 Continue with “To configure the date and time.”

To configure the date and time

1 Enter the correct date and time.

2 Select the time zone for your geographical area.

Example: (GMT -05:00) Eastern Time (US & Canada). 

3 Ensure the check box for Automatically adjust clock for daylight saving 
changes is checked.

4 Click Close to continue.

Result: Windows NT Setup detects the installed display adapter. The 
detected display window appears to explain which video adapter was 
located in the system. 

5 Continue with “To configure the display adapter.”

To configure the display adapter

1 Click OK to accept the detected video adapter. 

Result: You are prompted to configure the display adapter.
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2 Ensure the settings match your monitor requirement, and make changes if 
necessary. 

Example: 

Note: You must test these settings before Windows NT Setup allows you to 
proceed. 

3 Click Test to start the test.

Result: You are prompted to continue with the test.

4 Click OK to proceed with the display settings test.

Result: A test screen appears. After 5 seconds, the system asks you to 
verify that the colors and images on the screen match the text. A window 
appears with the question Did you see the test bitmap 
properly?

5 If the screen looked correct, click Yes.

If the screen did not look correct, click No. 

Note: If the screen did not look correct, there might be a hardware problem. 
Contact your Nortel Networks support representative.

Result: You are prompted to save the display settings.

6 Click OK to save the display settings you just tested.

7 Click OK to finalize the display settings and continue with Windows NT 
Setup.

Result: Files are copied to the system. Windows NT Setup sets security on 
system files and saves the system configuration. When the save is 
complete, you are prompted to reboot.

8 Continue with “To finish Windows NT installation” on page 213.

Display adapter setting Value

Desktop area 800 by 600 pixels

Color palette 256 colors

Font size Small Fonts

Refresh Frequency 60 Hertz
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To finish Windows NT installation

1 If you performed the Windows NT installation from the CD-ROM, remove 
the CD-ROM from the CD-ROM drive.

2 Click Restart Computer to complete the Windows NT Setup.

Result: Windows NT Setup restarts the server and boots to Windows NT.

3 Continue with “To reenable Console Redirection” on page 214.
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Completing the system build

Introduction

After installing Windows NT, you must do the following:

� Reenable Console Redirection.

� Remove any temporary files that were created on the MS-DOS partitio

� Install the tape drive driver.

Tape drives are used to perform backups of the CallPilot system softwa
and databases.

To reenable Console Redirection

1 At the Press <F2> to enter Setup, <ALT> to bypass PC Card  
boot prompt, press F2.

2 Press F9 to select Restore Defaults, and then press Enter.

3 Select Save Changes and Exit, and then press Enter.

Result: The system reboots with the new BIOS settings.

To clean up the MS-DOS partition

1 Log on to Windows NT.

Note: If you receive the following message, either one or both of the IP 
addresses configured for the ELAN or CLAN NICs are not unique. You must 
enter unique IP addresses.

The system has detected an IP address conflict with another system on the 
network. The local interface has been disabled. More details are available 
in the system event log. Consult your network administrator to resolve the 
conflict.

If you are configuring more than one 200i server in a single switch, ignore 
this message and click OK to continue.

2 In the Welcome to Windows NT window, click Close.

3 Click Start > Run.
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4 In the Run box, type c:\cleanup.bat  and press Enter.

To install the tape drive driver

1 Click Start > Settings > Control Panel.

Result: The Control Panel appears.

2 Double-click the Tape Devices icon.

Result: The Tape Devices control panel opens. Windows NT attempts to 
detect the installed tape drive. The list of available tape drive device drivers 
appears.

3 Click the Drivers tab, and then click Add.

Result: You are prompted to install a driver.

4 Click Have Disk.

Result: You are prompted to insert the manufacturer’s installation disk.

5 Type the path c:\200tmp\tape\oemsetup.inf , and then click OK.

Result: You are prompted to select a device driver from the displayed list.

6 Select Seagate tandqic (Tandberg Data QIC SCSI drives, all), and then 
click OK to continue.

Result: You are prompted for the path to the OEM Tape Device files.

7 Type the path c:\200tmp\tape\oemsetup.inf , and then click Continue.

Result: The driver files are copied to the system. You are prompted to 
restart the computer.

8 Click Yes to restart the computer.

Result: The computer restarts.
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Installing service packs

Introduction

A service pack is an update that Microsoft provides for Windows operating 
systems. Service packs provide new versions of files and fixes for problems
have been reported.

Note: The current service pack is SP5. 

To log on to Windows NT

1 Log on to Windows NT.

Note: The following message appears if either one or both of the IP 
addresses configured for the ELAN or CLAN NICs are not unique:

The system has detected an IP address conflict with 
another system on the network. The local interface has 
been disabled. More details are available in the system 
event log. Consult your network administrator to 
resolve the conflict.

. 

CAUTION

Risk of system crash
The service pack should only be installed during the operating 
system installation and as part of an upgrade from a 1.0 CallPil
system. Do not reapply the service pack on an installed CallPilo
system except where specifically instructed to do so in the 
documentation. 

. 

CAUTION

Risk of system crash
If you are upgrading from 1.0 or 1.06, install the updated SCSI 
driver before you install the service pack. See “ Installing the 
updated SCSI driver” on page 220.
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You must enter unique IP addresses.

If you are configuring more than one 200i server in a single switch, ignore 
this message and click OK to continue.

2 If Windows displays hint windows, uncheck the Show this Welcome screen 
the next time you start Windows NT.

3 If the Control Panel is open, close it.

To install the service packs

Note: If you are upgrading from 1.0 or 1.06, install the updated SCSI driver 
before you install the service pack. See “ Installing the updated SCSI driver” on 
page 220.

1 Insert the PEP CD-ROM in the CD-ROM drive.

Result: The Windows NT Setup screen appears.

2 Close the screen using the [x] in the upper right corner of the window.

3 Click Start > Programs > Windows NT Explorer.

4 Click the plus sign (+) next to the CD-ROM drive to display its 
subdirectories.

5 Select the directory named Service Pack 5.
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6 Double-click the folder US-40bit, and then double-click the file named 
SP5I386.

Result: Files are extracted, and then a Welcome screen appears.

7 Select the check box to accept the licence agreement.

8 Select the check box for backup files.

9 Click Install.

10 Click Finish to finish installing the service pack.

Result: The program examines the system, selects the files to copy, and 
then copies them. If messages appear, refer to the next step for the action 
to take in response.

11 As the files are installed, the following message might appear: The 
target file exists and is newer than the source. 
Overwrite the newer file?  Click No in response.
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When asked if you want to replace a file, always click No in response.

Result: When the installation is complete, the following message appears:

12 Click Restart.

13 After the server is restarted, remove the CallPilot PEP CD.

What’s next?

If you are upgrading CallPilot, then continue with the upgrade procedure. 

If this is a new installation, continue with “ Installing the updated SCSI driver” 
on page 220.
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Installing the updated SCSI driver

To install the updated SCSI driver

1 Create a local directory c:\sym53c86.

2 Insert the PEP CD-ROM.

3 Copy all eight files from the SCSI Driver directory on the PEP CD-ROM to 
c:\sym53c86 directory.

4 Click Start > Settings > Control Panel.

5 Double-click SCSI Adapters.

6 Click the Drivers tab.

a. Highlight the old driver, Symbios Logic C810 PCI SCSI Host Adapter, 
and click Remove.

b. Click Add and click Have Disk, and then click Browse to c:\sym53c86.

7 Highlight the Oemsetup (file type .inf) and click Open to install the new 
SCSI driver, Symbios Logic PCI (53c8xx).

8 Click OK, and then click OK again.

9 When prompted to input the full path to the OEM SCSI Adapters, type 
c:\sym53c86  in the box and click Continue.

10 Click Yes to restart to make the new driver effective.

11 After the system is up, go to the Control Panel > SCSI Adapters > Drivers 
tab. Double-check that the new driver is present.

What’s next?

If you are upgrading CallPilot, then continue with “ Installing service packs” on 
page 216. 

If this is a new installation, continue with “ Installing pcANYWHERE32 on the 
200i server” on page 221.
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Installing pcANYWHERE32 on the 200i server

Introduction

The process of installing pcANYWHERE32 involves the following procedur

1. Install the pcANYWHERE32 application on the server.

2. Start pcANYWHERE32 for the first time. This procedure allows you to s
the network device. 

3. Set the video mode. This procedure synchronizes the video card settin
with that of the administration client PC to ensure that the remote user 
see the server graphical user interfaces properly. 

4. Set the pcANYWHERE32 service to Automatic. This procedure enable
the pcANYWHERE32 service to start automatically after reboot. 

To install pcANYWHERE32 on the 200i server

1 Log on as Administrator.

2 Insert the server Operating System CD-ROM into the CD-ROM drive.

3 Ensure all other Windows applications are closed.
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4 Launch the pcANYWHERE32 installation program as follows:

Result: The Welcome to pcANYWHERE setup program window appears.

5 Click Next to start the installation.

Result: The User Information window appears.

6 Enter both the user and the company names, and then click Next.

Note: Ensure that the name and company are the same as those entered 
during the Windows NT installation.

Result: The Online License Agreement window appears.

7 Click Yes to accept the software license agreement.

Result: The Choose Destination window appears.

8 Click Next to accept the default directory.

Result: The Setup Review screen appears.

IF you are 
installing from THEN do the following

the CD-ROM drive With Windows Explorer, navigate to the 
Installs\Pca32\Disk1 folder on the CD-ROM drive as 
follows:

� Double-click Installs.

� Double-click Pca32.

� Double-click Disk1.

� Locate and double-click the Setup file.

the LAN � Ensure that the CD-ROM has been inserted into 
the remote computer.

� Click Start > Run, and then type 
\\computername\sharecddrive\installs\pca32\
disk1\setup.exe

� Result:  The Enter Network Password window 
might appear.

� Enter the remote computer’s user ID and 
password in the Connect As and Password fields, 
respectively, and then click OK.
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9 Click Next to continue.

Result: Some files are copied to the system. When installation is complete, 
the Symantec Support Solutions screen appears.

10 Click Next to continue.

Result: The How To Reach Us screen appears.

11 Click Next to continue.

Result: The Windows 95 Solutions screen appears.

12 Click Next to continue.

Result: The Registration screen appears.

13 Click Skip.

Result: You are asked if you want to view the README file now.

14 Click No.

Result: You are prompted to restart the computer.

15 Select No, I will restart my computer later, and then click Finish.

Result: pcANYWHERE32 setup terminates.

To start pcANYWHERE32 for the first time

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

Result: The Smart Setup Wizard window appears, and you are prompted 
for the modem device.

2 Ensure that the Sportster 28800-33600 External modem is selected. 

3 Click Next.

Result: The system prompts you to select the network device.

4 Ensure that only TCP/IP is selected, and then click Next.

Result: The system prompts you to select a port.

5 Ensure that you select COM1, and then click Finish.

Result: The pcANYWHERE32 window appears.
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To set the video mode

1 From the File menu, select Application Options.

Result: The Application Options dialog box appears.

2 Click the Host Operations tab.

3 In the Video mode selection drop-down list, select Default — Accelerator 
Enabled, then click Apply

4 Click OK to close the window.

Result: The pcANYWHERE32 window appears.

5 To finish the installation, on the pcANYWHERE32 window, click File > Exit.

6 If you performed the installation from the CD-ROM drive, remove the CD-
ROM from the drive.

pcANYWHERE patch installation

Note: The pcANYWHERE32 patches are located on the CallPilot server CD
the following directory: platform\default\nortel\data\PCANYW_1.

1 Install the 802up_a Patch. From the CallPilot server CD, run 
platform\default\nortel\data\PCANYW_1\802up_a\disk1\setup.exe.

2 Double-click the setup.exe icon. 

Result: The Welcome window appears.

3 Click Next. 

Result: The Start Copying Files window shows the path for copying files.

4 Click Next. 

Result: Setup copies files to the directories, and then the Setup complete 
window appears.

5 Select No, I will restart my computer later, and then click Finish.

Note: Do not restart the computer.

6 Install the 802up_b Patch. You can find the setup.exe file for this patch on 
the CallPilot server CD in the following directory: 
platform\default\nortel\data\PCANYW_1\802up_b\setup.exe.
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7 Double-click setup.exe. 

Result: The Welcome window appears.

8 Click Next. 

Result: The Start Copying Files window appears, showing the path for 
copying files.

9 Click Next. 

Result: Setup copies files to the directories, and then the Setup Complete 
window appears.

10 Select No, I will restart my computer later. 

11 If you see the following screen, ensure that the check box is unchecked, 
and then click Finish. 

12 Restart the computer by clicking Start > Shutdown. Select Restart the 
Computer, and then click OK.

To set the pcANYWHERE32 service to Automatic

1 Click Start > Settings > Control Panel.

2 Double-click Services.
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3 Scroll to pcANYWHERE Host Service, and highlight the service.

4 Click Startup.

Result: The Service dialog box appears.

5 In the Startup Type area, select Automatic.

6 Click OK.

7 Close the Services window, and exit the Control Panel.

What’s next?

Install the CallPilot server software.
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Installing CallPilot server software

Introduction

This section describes the steps required to install CallPilot software on a 
CallPilot server that is already loaded with the Windows NT 4.0 operating 
system and the device drivers required by CallPilot.

Requirements
� CallPilot 1.07 Server CD

� CallPilot 1.07 PEP CD

� CallPilot 1.07 Language CD

� a server powered up, with Windows NT 4.0, service pack 5, and all the
device drivers installed

� the current password for the Administrator account (This password was
during the installation of Windows NT.)

To install the CallPilot server software

1 Insert the CallPilot 1.07 Server CD into the CD-ROM drive and launch 
Windows NT Explorer.

2 Click the CD-ROM drive, and then double-click setup to start the CallPilot 
installation. 

Result: The Nortel System Operations window appears.

ATTENTION During an installation, there are stages during which th
setup program performs automatic installation steps 
between setup windows. Do not close or click on any 
windows that appear during these steps unless you are
prompted. Wait for the next wizard setup window before
you use the mouse or keyboard. 
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3 Click Next. 

Result: You are asked to confirm the installation of CallPilot files onto your 
PC. 

4 Click Yes.

Result: You are prompted to start the platform setting procedure. 
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5 If the server is a 200i, 702t, or a 1001rp, click Yes to perform the platform 
setup from CD.

Result: The Platform Type Information Test Application window appears.

6 Type 1 to set the platform type and press Enter.

Result: The system prompts you to identify the machine class.
.

7 Type 1 for the 702t or the 1001rp.

Type 2 for the 200i.

Result: The system prompts you to identify the machine type.

8 Type 1 for the 702t.

Type 2 for the 1001rp.
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Type 3 for the 200i.

Result: The system prompts you to identify the platform series.

9 Type the number that identifies your server’s model number. Press Enter.

Result: The Select the backplane type prompt appears.

10 Type 1 for the 200i or the 702t.

Type 2 for the 1001rp.

Result: The Nortel System Operations window appears and shows the 
current platform settings based on your responses.

11 If the settings are correct, click Yes to initiate the installation. Otherwise, 
click No to rerun the platform setting procedure.
230 CallPilot



May 2000 Installing the operating system and server software (for recovery purposes)
12 The installation setup process runs automatically (taking 15 to 30 minutes). 
A series of messages appear to indicate the items that are being installed 
(for example, backup/restore, MMFS). 

Result: When installation is complete, the following prompt window 
appears:

13 Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.

What’s next?

Install any required PEPs. 
Part 5: 200i Server Maintenance and Diagnostics 231



Installing the operating system and server software (for recovery purposes) Standard 1.0

ges 

new 
/nic.

e 
r 

les 
 
 

s 
u 
Installing PEPs

Introduction

For an initial installation of CallPilot, the Performance Enhancement Packa
(PEPs) are provided on a CD.

If you are using this procedure for a CallPilot system that is up and running, 
PEPs are issued on the NIC web site at http://www.nortelnetworks.com/prd

You require a password to access this site.

Identifying the PEPs

PEPs are labeled on the CD in the following format:

NMxxyyzzPwwwQ

. 

CAUTION

Risk of system problems
For specific PEP installation instructions, refer to the readm
files that are in the PEP CD root directory and in the folde
for each PEP package. In many cases, PEPs must be 
uninstalled and installed in a specific order. The readme fi
provide these instructions. When the readme files instruct
you to uninstall or install PEPs, refer to the procedures in
this section.

ATTENTION If your CallPilot system is up and running, Nortel Network
recommends that you perform a system backup before yo
install a new PEP. 

See the Monitoring and Security for the Administrator guide 
for more information on performing a backup.
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Readme files

Readme files are provided in the following locations on the PEP CD:

� the root directory on the PEP CD

This readme file provides a general description of the PEP packages a
general PEP install and uninstall instructions.

� in each PEP package folder

These readme files provide a list of all the PEPs in that package, and 
specific PEP install and uninstall instructions.

� in each PEP folder

These readme files describe the purpose of that PEP and might provid
some PEP installation instruction.

To install a PEP package

1 Ensure that you are logged on to the server where you are going to begin 
PEP installation. Use a logon account that has administrative privileges (for 
example, administrator).

2 Insert the CallPilot 1.07 PEP CD. 

xxyyzz is the release level (for example, 
010707).

P can be R for a restricted PEP, D for a 
diagnostic PEP, or G for a general 
PEP.

www is the PEP number for the release. 
The range is from 001 to 999.

Q indicates the platform type (for 
example, S denotes a PEP for the 
server).
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3 Read the readme files that are in the PEP CD root directory and in the 
folder for each PEP package for specific uninstallation or installation 
instructions, or both.

4 Double-click runme.exe.

Result: Setup examines the system, and the PEP’s to install window 
appears. 

Note: The following example is for illustration purposes only, and might not 
reflect what appears on your system:

ATTENTION It can take 5 to 20 minutes for the PEPs to install window 
to appear, depending on the number of PEPs and the 
system configuration. In the meantime, a gray box might 
appear while the window is loading. Do not use the 
mouse or keyboard during this time.
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5 Select the PEPs to install, and then click Next. If you are uncertain about 
which PEPs to install, refer to the Readme file located in the root directory 
of the CD.

Result: The Nortel System Operations window appears and lists all 
components in the order in which they will be installed. 
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6 Click Yes to continue.

Result: The system automatically shuts down all services and the PEPs 
are installed. A summary of the installation appears, showing the success 
or failure of each PEP operation.

Note: CallPilot automatically removes obsolete PEPs when you install new 
PEPs.

7 Click Yes to complete the procedure.

Result: The program ends.

8 Repeat this procedure for other PEP packages. A reboot is required after 
installing PEPs.

To uninstall a PEP package

CallPilot automatically removes obsolete PEPs when you install new PEPs
However, there can be times when you want to uninstall a PEP yourself. 

Use the DMI Viewer on the server to view or uninstall server PEPs. Access
DMI Viewers by clicking Start > Programs > CallPilot > System Utilities > PE
Maintenance Utility.

To uninstall PEPs on the server, follow these steps.
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1 Log on to the server where you are going to begin the PEP uninstall. Use a 
logon account that has administrative privileges (for example, 
Administrator).

2 Open the DMI Viewer.

The DMI Viewer window appears. The following example might not reflect 
exactly what appears on your system:

3 To view a list of all PEPs, click Show PEPs.

Result: A list of all PEPs appears.
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4 Select the PEP you want to uninstall. You can select multiple PEPs to 
uninstall in one operation by using the Ctrl key. The prefix PEP identifies 
PEPs.

5 Click Remove.

Result: The system prompts you to confirm this choice.

6 Click Yes.

Result: The system automatically shuts down all services and uninstalls 
the selected PEPs. When the uninstall is finished, the system automatically 
restarts all services.

Note: After you uninstall a PEP, the PEP is still visible in the list of 
components until you restart DMI Viewer.

7 When you are finished, close the DMI Viewer window.
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.

What’s next?

IF THEN 

you are installing a new CallPilot 
system

continue with the CallPilot server 
Configuration Wizard, which is 
described in Part 3 of this binder.

you are recovering from a hard drive 
failure

continue with the recovery steps 
outlined in the General Release Bulletin
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Upgrading CallPilot server software

In this chapter
Pre-upgrade checklist 242

Preparing for the upgrade 247

 Upgrading from 1.0 or 1.06 to 1.07 251
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Pre-upgrade checklist

Introduction

This section provides an upgrade readiness checklist that should be perform
before attempting the upgrade at the customer site. This enables you to

� avoid significant lost time and costs 

� significantly reduce system downtime resulting from upgrade problems 
might have been prevented

A summary of the upgrade readiness checks includes the following steps:

� Ensure dial-up networking can be established with the CallPilot server.

� Ensure a pcANYWHERE32 session can be established with the CallPi
server.

� Ensure the MMFS is less than 90 percent full.

� Check if the customer has recorded customized prompts.

� Check Meridian 1 for required software, feature packages, and patches

� Check system information, such as keycode and serial number.

� Check for “critical” PEPs that have been issued since the release of the
1.07 build.

If one of these readiness checks fails, the failure should be corrected befor
attempting the upgrade again. Details of the readiness checks follow.

To ensure a dial-up networking session can be established with 
CallPilot 

If the PC is not on an IP network connected to the CallPilot server, establish
connection using Dial-Up Networking.

1 Click Start > Programs > Accessories > Dial-Up Networking.

2 Double-click the MAS icon.
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If the icon is unavailable, create a MAS connection profile. See “Creating 
the MAS connection profile” on page 470 of the CallPilot 1.0 Maintenance 
and Diagnostics Guide.

3 When prompted, enter the Windows NT logon ID and password.

4 Wait until the connection is established.

To ensure a pcANYWHERE32 session can be established with 
CallPilot 

If pcANYWHERE32 is not functioning prior to the upgrade, the upgrade will
not change this. If the upgrade is performed and a problem occurs, remote 
support access is not possible.

Do not attempt an upgrade to CallPilot 1.07 until pcANYWHERE32 is 
functioning.

Given a dial-up networking session has been established, establish a 
pcANYWHERE32 connection to the CallPilot server:

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

2 Double-click the remote control icon for the server.

3 If the icon is unavailable, create a server connection profile. See “To create 
a remote control connection icon” on page 470 of the CallPilot 1.0 
Maintenance and Diagnostics Guide.

4 When prompted, enter the pcANYWHERE32 logon ID and password.

If a pcANYWHERE32 session cannot be established, open a ticket with No
Networks CTS. You require pcANYWHERE32 access for remote support.

Ensure MMFS volume on Disk 1 is less than 90 percent full

Use the administrative client to check that the MMFS volume on Disk 1 (dri
D) is less than 90 percent full. Do not proceed with the upgrade if the MMF
volume on Disk 1 (drive D) is greater than 90 percent full. 

If the MMFS volume is greater than 90 percent full, then the upgrade of the
system to the latest release of the voice prompts might fail.
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d.   
To find out how much space is used on each volume, follow these steps:

1 On the Administrative client, select SMI > System Administration > System 
Performance Monitoring. Double-click Reporter Download Schedule.

Result: The system displays the “Select the drive for the local OM 
database” dialog box.

2 Click OK to continue.

3 From the Reporter Download Schedule window, press Download Now. 

Note: If Nortel Communicator is not running, the system prompts you to 
start the Communicator. Click Yes to continue. 

4 Select an interval for the OM collection period and click OK. A smaller 
interval downloads more quickly. 

Result: The system downloads the Operational Measurements data from 
the server to the client PC.

5 When the OM download is complete, click Save.

6 To run the system reports, select Start > Programs > MAS Reporter > 
Reports. The default password for Reporter is “password.” You might need 
to change the password if you have not already done so. 

7 Select your system name > Reports. Double-click the System folder and 
double-click Multimedia File System Usage Monitor Report.

8 Specify an interval.

9 Click OK.

Result: A report appears that shows the amount of text and voice space 
used for each of the volumes on the system.

10 Exit Reporter.

Check if custom prompts have been recorded

Use the administrative client to check if custom prompts have been recorde

View the prompts in the System Prompts Customization main window by 
selecting one of the following paths.
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For 1.0 systems
Nortel SMI > Meridian Application Server > CallPilot > System Prompts 
Customization.

For 1.06 systems
Nortel SMI > Meridian Application Server > Messaging > System Prompts 
Customization.

If one or more prompts are custom, then archive the custom prompts by 
selecting one of the following paths.

For 1.0 systems
Nortel SMI > Meridian Application Server > CallPilot > Archive & Restore >
Archive Manager

For 1.06 systems
Nortel SMI > Meridian Application Server > Messaging > Archive & Restore
Archive Manager

After the upgrade to 1.07, the custom prompts can be restored on the syste
from the archived copy.

Ensure the Meridian 1 switch has required patches 

Check the Meridian 1 patches against the requirements stated in Part 3, Ch
3. If the required patches are not present on the Meridian 1, do not proceed
an upgrade until the Meridian 1 switch is ready. Without the required patche
the Meridian 1, ring-no-answer and other issues can result.

Checking system information

To locate information about your system that you might need for the upgrad
click Start > Programs > CallPilot 1.0 (or 1.06) Server > CallPilot System 
Information. Ensure that the

� Security Device ID (Sec. Dev. ID) on the 1.07 keycode label matches t
CallPilot serial number that appears on the CallPilot System Informatio
dialog box. If these two items do not match, your Nortel Networks 
Part 5: 200i Server Maintenance and Diagnostics 245



Upgrading CallPilot server software Standard 1.0

 can 

qual 
g 

oice 
ber 

 > 
e the 

sword 
rior 
customer support representative must generate a new keycode so you
upgrade your system.

� feature limits displayed on the 1.07 keycode label are greater than or e
to the feature limits displayed on the CallPilot System Information dialo
box.

Features cannot be reduced. For example, if you currently have three v
prompt languages installed on your system, you cannot reduce the num
of languages to two. 

Check for critical PEPs that have been issued since 1.07 was released

Check the NIC web site at http://www.nortelnetworks.com/prd/nic (Products
CallPilot) for any additional PEPs that might have been made available sinc
manufacture of the PEP CD. If critical PEPs are available, apply them 
immediately after installing the PEPs from the PEP CD.

Note: The NIC web site is a secure site and requires a user name and a pas
to log on. If you do not currently have an account, you must apply for one p
to entry. Be advised that it might take three to five business days for your 
account request to be processed.
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Preparing for the upgrade

Introduction

Use the procedures in this section to upgrade to a new release of CallPilot 
software. Upgrading involves replacing the CallPilot software with a higher 
numbered release. 

You can upgrade:

� from a previous release (1.0 or 1.06)

� from a previous release (1.0 or 1.06) after performing an expansion

� from a previous release (1.0 or 1.06) at the same time as performing a
expansion

Note: You cannot downgrade to a previous version of CallPilot software.

Timing

The upgrade process takes approximately 60 minutes.

Requirements
� a 1.07 keycode

� CallPilot 1.07 Server CD

� CallPilot 1.07 PEP CD

� CallPilot 1.07 Language CD

� a copy of the latest General Release Bulletin (GRB). It is important that 
review this document for special instructions before starting the upgrad

� a CallPilot mailbox, a telephone set, and the phone number of the 
customer’s IVF Messaging application to check that CallPilot is operatio
after the upgrade

� if the customer has the fax or speech recognition options, a fax machine
the phone numbers for Express Fax Messaging, Speech Activated 
Messaging, or both
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Upgrade checklist

Before you begin

To start services
Check that all services starting with the prefix MAS and CallPilot (MCE) are 
and running before starting the upgrade. 

1 Click Start > Settings > Control Panel > Services.

2 Select the MAS and CallPilot (MCE) services that have not been started.

3 Check that the startup states are set to Automatic.

4 Click OK to confirm.

5 Exit the Services application.

Step ✔

Review the pre-upgrade checklist on page 242.

Disable all DSP and DS30 channels. Refer to “To disable all 
DSP and DS30 channels from the Administrative PC” on page 
249 for more information on performing this step.

Have on hand a 1.07 keycode and serial number. Check that the 
keycode and serial number are valid by following the steps listed 
in “Checking system information” on page 245.

Obtain the current password for the Administrator or NGenSys 
account. 

If you are unfamiliar with these passwords, contact the 
company’s network administrator. 

Start services. See “To start services” below for more 
information.

Perform a full backup. 

See the Monitoring and Security for the Administrator guide for 
the backup procedure.
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To disable all DSP and DS30 channels from the Administrative PC
Before upgrading the server, disable the DSP and DS30 channels and then
down the Administrative PC. 

1 From the Administrative PC, click Start > Programs > CallPilot 
Administration Client.

Result: An Explorer window appears.

2 Click your server icon.

Result: The SMI Login screen appears.

3 Enter your user ID and password, and then click OK.

4 From the Administration Menu, select System Administration > 
Maintenance Administration.

5 Double-click the Channel Monitor option.

Result: The DS30 channels appear. 

6 Highlight the channel by clicking the DS30 channel entry.

7 From the File menu, select Courtesy Stop.

Result: The highlighted DS30 channel changes to off-duty status and 
becomes disabled.

8 Double-click the Multimedia Monitor option.

Result: The DSP channels appear.

9 Highlight the channel by clicking the DSP channel entry. 

10 From the File menu, select Courtesy Stop.

Result: The highlighted DSP channel changes to off-duty status and 
become disabled.

11 After disabling all DSP channels, dial in to CallPilot to test that the lines are 
disabled. You should receive a busy signal.

12 Shut down the Administrative PC.

If you upgrade from a networked CD
If you perform an upgrade from a networked CD, the machine that serves t
CD must have Windows NT 4.0 (Server or Workstation) and be accessible 
the LAN.
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To prepare a keycode file
You require a new keycode to upgrade your CallPilot system. This keycode
should be different from the keycode supplied with your initial CallPilot syste

You can either manually enter the keycode or read it from a file. To prepare
file, follow these steps:

1 Open a document in a text-editing application (such as Notepad). The 
keycode is supplied by Nortel Networks, and consists of 7 sets of 4 
alphanumeric characters.

2 Type the keycode into the file, placing a space between each set of 
characters.

3 Save the file as a *.kc document.
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Upgrading from 1.0 or 1.06 to 1.07

To upgrade to a newer release

1 Log on to the server using an account with local administrative privileges 
(for example, Administrator or NGenSys).

2 Close all applications except for pcANYWHERE32, acdproxy, Sybase, and 
the MASTraceWindow.

3 Disable all DSP and DS30 channels using the administrative PC. Refer to 
“To disable all DSP and DS30 channels from the Administrative PC” on 
page 249 for instructions on how to stop these channels.

4 If you are upgrading from CallPilot 1.0 or 1.06, install the latest SCSI driver 
and then install service pack 5 before you start the upgrade. Refer to 
“Installing the updated SCSI driver” on page 220 and “Installing service 
packs” on page 216. 

5 Insert the 1.07 Server CD in the CD drive.

6 From the Windows taskbar, click Start > Run.

7 Click Browse.

Result: A Browse window appears.

8 Select the CD-ROM drive and double-click setup.exe.

9 Click OK from the Run window.

Result: The Nortel System Operation window appears. 
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10 Click Next to continue with upgrade.

Result: Setup examines the system and then prompts you to confirm the 
upgrade.

11 Click Yes to start the upgrade. 

Result: The Keycode and Serial Number window appears.
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12 Enter the new 1.07 keycode, and then click Next. 

Result: The Features Verification window appears.

13 Click Next. 

Result: Setup automatically uninstalls previous PEPs as part of the 
upgrade procedure. After all PEPs have been uninstalled, a dialog box 
appears, showing the PEPs that have been uninstalled. 
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14 Click OK to continue. 

Result: You are prompted to confirm the platform settings for your system. 
If the settings are correct, click Yes. Otherwise, click No. 

15 The upgrade process runs automatically. A series of messages appear to 
indicate the items that are being updated (for example, backup/restore, 
MMFS). 

16 After the upgrade is complete, setup prompts you to install PEPs.

17 Click Yes to continue. Remove the Server CD and insert the PEP CD.

Refer to “Installing PEPs” on page 232 for more information on installing 
PEPs.

18 After all the PEPs are installed, restart the server. 

19 After the server restart, run the Configuration Wizard by clicking Start > 
Programs > CallPilot > Configuration Wizard.

To run the Configuration Wizard
20 Leave all current values in the Configuration Wizard dialog boxes as they 

are until you reach the Keycode and Serial Number dialog box shown here.
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21 Enter the serial number you received with the CallPilot keycode in the 
Serial Number box. This number should match the prefilled “Serial Number 
from dongle” box.

If the serial number contains letters, use lowercase.

Note: The Serial Number from dongle box is prefilled with data read from 
the software feature key.

22 The keycode is prefilled with the value entered in step 12. Verify that the 
keycode is correct.

23 Click Next through the remaining Configuration Wizard dialog boxes until 
the following dialog box.
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24 Remove the PEP CD and insert the CallPilot 1.07 Language CD.

25 Select Install Language.

26 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files 
on the CD. For example, if the CD-ROM is drive E:, select E:.
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27 Click Next.

Result: The following dialog box appears, which lists all currently installed 
languages:

28 Select the language you want to upgrade and click Next. 

Result: The Add Prompt Language dialog box appears.

29 To add a language, select the prompt language check box. Click Next.

Result: The Primary and Secondary Languages dialog box appears.

30 Click Next to accept the currently assigned primary and secondary 
languages.

Result: The Speech Recognition Languages dialog box appears.

31 Click Next to skip this dialog box.

Result: The language installation dialog boxes are completed.

32 Click Next through the remaining Configuration Wizard dialog boxes until 
the Ready to Configure dialog box appears.
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33 Select Apply the current configuration, and then click Next.

Result: The configuration changes are applied to the server. This is 
followed by a prompt to restart to CallPilot. 

Note: The configuration changes take approximately 10 minutes, plus an 
additional 10 minutes for each language you are reinstalling. 

34 Click Finish, and then click Cancel to bypass the restart. 

To enable the DSP channels
35 From the Administrative PC, click Start > Programs > CallPilot 

Administration Client.

Result: An Explorer window appears.

36 Double-click your server icon.

Result: The SMI Login screen appears.

37 Enter your user ID and password, and then click OK.

38 From the Administration Menu, double-click Multimedia Monitor.

Result: The DSP channels appear.

39 If the DSP channels are not enabled, skip to step 40. Otherwise, skip to 
step 42 to check the DS30 channels. 

40 Highlight the channel by clicking the DSP channel entry. 

41 From the File menu, select Start Channels.

Result: The highlighted DSP channel changes to online status and 
becomes enabled.

42 Double-click the Channel Monitor option.

Result: The DS30 channels appear. 

43 If the DS30 channels are not enabled, then skip to step 44. Otherwise, skip 
to step 46 to test the system. 

44 Highlight the channel by clicking the DS30 channel entry.

45 From the File menu, select Start Channels.

Result: The highlighted DS30 channel changes to online status and 
becomes enabled.
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46 After disabling all DSP channels, dial in to CallPilot to test that the lines are 
enabled. You should receive a prompt.

What’s next

Test that CallPilot can receive calls by following the procedures in Part 3, 
Chapter 11, “Verifying that CallPilot can receive calls.”
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In this chapter 
Expanding features 262
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Expanding features 

Introduction

This chapter summarizes how you add features to CallPilot.

CallPilot supports feature reduction only for those channels that have been
previously allocated.

Expansions

The following types of features can be expanded:

� channels 

� languages

� number of networking sites

� number of MPUs

� availability of features such as AppBuilderFax and Networking

To add features 

1 If you are adding channels (installing additional MPC-8 cards), see “To add 
an MPC-8 card” on page 178.

2 Install the software feature key if a new one was shipped to you. See 
“Replacing the Nortel Networks software feature key” on page 169.

3 Have your new keycode and serial number available. When you purchase 
additional features or system capacity, you receive a new keycode and 
serial number.

4 Run the Configuration Wizard (refer to Part 3, Chapter 6, “Configuring the 
server software—common dialog boxes for all switch types”). In the 
Configuration Wizard, ensure you follow these steps:

a. Enter the new keycode and serial number.
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b. Allocate new channels (if you have added channels).

5 Configure additional channels on the switch and in the Configuration 
Wizard.

ATTENTION
New channels are not automatically allocated. They must 
be allocated manually in the Configuration Wizard.
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Uninstalling CallPilot

Introduction

This section provides instructions to help you uninstall the CallPilot server 
software.

Uninstallation of CallPilot removes the software completely from the server.
also removes all CallPilot registry entries, linguistic information, and all links
CallPilot from the server database.

What is removed during uninstallation of CallPilot 

Uninstallation of CallPilot software removes the following:

� CallPilot entries in the Windows NT Registry 

� all CallPilot entries in the server database

� CallPilot files

Before you begin

Obtain the current password for the Administrator account.

To uninstall CallPilot server software

1 To uninstall CallPilot, click Start > Programs > CallPilot > Uninstall.

Result: You are prompted to confirm the uninstallation.

2 Click Yes to uninstall CallPilot.

Result: The uninstall process runs automatically. 

ATTENTION Once you start the uninstallation process, you cannot 
restore CallPilot if you decide to cancel the process. Yo
must perform a new installation to load CallPilot onto th
server. 
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3 After the CallPilot uninstall is complete, you are prompted to reboot the 
server.

4 Click Yes to reboot the server.

Result: You are asked to confirm the reboot.

5 Click OK to reboot.
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Reinstalling CallPilot server software

In this chapter
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Reinstalling the software (hard drive is 
functioning)

Introduction

If the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct
problem. If it does not correct the problem, then you need to rebuild the har
drive (see Chapter 11, “Recovering from a hard drive failure or corrupted 
software”).

The reinstallation procedure copies CallPilot program files from the CallPilo
Server CD-ROM to a CallPilot system running the same version of CallPilo
software. This process does not affect system or user data. It recovers mos
CallPilot program files, but does not recover the operating system, service p
or, in the case of non-Meridian 1 systems, switch drivers.

Requirements
� a CallPilot Server CD-ROM that has the same version of CallPilot that 

running on the CallPilot server

� a CallPilot Language CD

� a CallPilot PEP CD

To reinstall the CallPilot server software

Note: During the reinstall, the following message might appear. If this mess
appears, click OK and continue with the reinstall. 
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1 Log on to the CallPilot server.

2 Insert the CallPilot Server CD-ROM.

3 Run setup.exe from the root directory of the CallPilot Server CD-ROM.

Result: The following window appears:

4 Click Next.

Result: Setup examines the system and displays the following window:

5 Click Yes to reinstall the software.

Result: You are asked to confirm the platform setting for the server.
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6 Click Yes to begin the reinstallation of CallPilot software. 

Result: Files are copied to the server as part of the reinstall procedure. 
This can take up to 10 minutes. A series of messages appear to indicate 
the items that are being reinstalled (for example, backup/restore, MMFS).

After the reinstall is complete, you are prompted to reinstall PEPs (if any 
were present on CallPilot).

7 Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.

Refer to “Installing PEPs” on page 232 for more information on reinstalling 
PEPs.

8 After all PEPs are reinstalled, restart the server when prompted.

9 After CallPilot has restarted, run the Configuration Wizard (see Part 3, 
Chapter 6, “Configuring the server software—common dialog boxes for all 
switch types”).
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10 Leave all current values in the Configuration Wizard dialog boxes as they 
are until you reach the Language Source Directory dialog box shown here:

11 Insert the CallPilot Language CD.

12 Select Install Language.

13 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files 
on the CD. For example, if the CD-ROM is drive Z:, select Z:.
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14 Click Next.

Result: The following dialog box appears, which lists all currently installed 
languages:

15 Select all the languages listed and click Next. 

Result: The Add Prompt Language dialog box appears.

16 Click Next to skip this dialog box.

Result: The Primary and Secondary Languages dialog box appears.

17 Click Next to accept the currently assigned primary and secondary 
languages.

Result: The Speech Recognition Languages dialog box appears.

18 Click Next to skip this dialog box.
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Result: The language installation dialog boxes are completed.

19 Click Next through the remaining Configuration Wizard dialog boxes until 
you reach the following dialog box:

20 Select Apply the current configuration, and click Next.

Result: The configuration changes are applied to the server. This is 
followed by a prompt to restart to CallPilot. 

Note: The configuration changes take approximately 10 minutes, plus an 
additional 10 minutes for each language you are reinstalling. 

21 Click Finish, then click OK to restart CallPilot.

Result: The CallPilot software reinstallation is done. 

22 Test your CallPilot channels as described in Part 4 of this Installation 
binder.
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Reinstalling languages

Introduction

If the language prompts are not functioning, then you can reinstall them to t
and fix the problem.

Requirements
� a CallPilot Language CD

To reinstall languages

1 Log on to the CallPilot server.

2 Run the Configuration Wizard as described in Part 3, Chapter 6, 
“Configuring the server software—common dialog boxes for all switch 
types”.
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Overview

Introduction

If the CallPilot server hard drive crashes or if software becomes corrupt, the
you must either reinstall the software or rebuild the hard drive. 

Reinstalling languages

If only the language prompts are not functioning, then you can reinstall 
languages to try to fix the problem. See “Reinstalling languages” on page 276.

Recovering from corrupted software (hard drive is functioning)

If the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct
problem. See “Reinstalling the software (hard drive is functioning)” on page 
270. If it does not correct the problem, then you need to rebuild the hard driv

Recovering a CallPilot system from a hard drive failure

If this is a CallPilot system that is already in operation and backup tapes ar
available, then contact your distributor to perform the recovery procedure. 
Distributors should refer to the latest General Release Bulletin on the Norte
Networks web site at http://www.nortelnetworks.com/nic for the latest 
procedure.

If this is a new CallPilot system and no backup tapes are available (for exam
the system failure occurs during CallPilot installation), then see Part 1, Cha
3, “Installing server software for recovery purposes.” This procedure erases
existing data on the server. 

ATTENTION Contact your distributor if a hard drive recovery is required.
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Recovering from a hard drive failure

Introduction

Contact your distributor if a hard drive fails. Your distributor has access to a
utility that is required to restore data from a backup tape.

Requirements
� all software media that came with the CallPilot system

� a system backup

ATTENTION The recovery procedure requires access to a utility that is n
available to customers. Distributors should refer to the lates
General Release Bulletin on the Nortel Networks web site a
http://www.nortelnetworks.com/nic for the latest procedure.
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Part 5: 200i Server Maintenance and Diagnostics 283



Index Standard 1.0
installation overview 185–186
installing from CD-ROM 197

Windows NT configuration
date and time 211
display adapter 211
drivers and devices 199
Etherlink III card settings 206
formatting the hard drive 200
network interface drivers 203
network protocols and services 205
network server 203
network services 207
network settings 208
Setup Wizard 201
Token Ring card settings 206

hardware
diagnostics

Windows NT 4.0 51
hardware problems

how to isolate and fix 90
indications of 89

hex display
boot sequence indicators 29
functions 29
location on 200i server 26
server status indicators 30

I
indicators, boot sequence

hex display 29
LED 27

installing
MPC-8 cards 178

the correct way 177
MS-DOS (hard disk recovery) 191
network interface card 173
pcANYWHERE32 221

overview 221
service packs, Windows NT 217
tape drive driver 215
Windows NT (hard disk recovery)

from CD-ROM 197
Windows NT from LAN 194

integrated diagnostics

running 116
ipconfig command 57

L
Last Result button 105
LED

boot sequence indicators 27
functions 27
location on 200i server 26
MPC card slots

description 178
server status indicators 28

LEDs
MPC card slots

picture 177
logging on to Windows NT 216
logs 54
logs, viewing

event 43

M
maintenance activities 16
Maintenance tab of Maintenance window 99
maintenance tools 14
Maintenance window

description of 99
purpose 98

materials checklist 17
modem

connection, Console Redirection
200i server, shutting down 80
client PC, configuring 80
modem properties, configuring 80
requirements 76

motherboard components
stiffener, picture 165

MPC card slots
LEDs

description 178
picture 177

MPC cards
caution 176, 177, 180

MPC-8 cards
284 CallPilot



May 2000 Index
inserting correctly 177
picture 178

installing 178
picture 176

MS-DOS
diagnostics, running with Console 

Redirection 83
installation, attention 191
installing (hard disk recovery) 191
partition, cleaning up 214
utilities, using with Console Redirection 83

N
nbstat command 65
netstat command 67
network interface card

installing 173
picture 173

noncritical bootup diagnostics
codes 33
description 33

noncritical OS and switch diagnostics
codes 34
description 34

O
OS and switch diagnostics, noncritical

codes 34
description 34

P
partition, cleaning up the MS-DOS 214
PC cards

supported 172
pcANYWHERE32

difference from Console Redirection 72
installation overview 221
installing 221
setting as automatic service 225
starting

for the first time 223

video mode, configuring 224
performance enhancement packages (PEPs)

identifying types 232
installation procedure 233
readme files 233
running a system backup 232
shutting down services 236
using the DMI viewer 236

pictures
200i server

hex display, location 26
LED, location 26

DIMM  161
EIDE hard drive 167
motherboard stiffener 165
MPC card slot LEDs 177
MPC-8 card 176

correct installation 178
network interface card 173
software feature key 170

ping command 59
Token Ring diagnostics 69

POST diagnostics
failure 40, 41
results, viewing 37
successful 37, 39

Power Down button 103
Power Up button 103
Power-On Self-Test (POST)

definition 37
diagnostics 37

precautionary messages 14

R
recovering from a hard disk failure 277
recovery of hard disk

200i server software installation 187
MS-DOS

installation overview 185
service packs, installation overview 186
system BIOS

configuration overview 185
configuring 190

what you need 185
Part 5: 200i Server Maintenance and Diagnostics 285



Index Standard 1.0
Windows NT
installation overview 185–186
installing from CD-ROM 197

Windows NT configuration
date and time 211
display adapter 211
drivers and devices 199
Etherlink III card settings 206
formatting the hard drive 200
network interface drivers 203
network protocols and services 205
network server 203
network services 207
network settings 208
Setup Wizard 201
Token Ring card settings 206

removing the 200i server 150
replacement part numbers

obtaining 122
Replacement tab of Maintenance window 99
replacing

the 200i server 152
restrictions, Console Redirection 73

S
safety precautions 17
security logs 54
server, 200i

motherboard components
equipment needed for replacement 163

Windows NT configuration (hard disk 
recovery)

Etherlink III card settings 206
network protocols and services 205

service packs, installing 217
shutting down the 200i server 148
software

maintenance 261
software feature key

equipment needed for replacement 169
picture 170
replacing 170

SQLAnywhere 149
starting pcANYWHERE32

on the 200i server 223
supported PC cards 172
symbols used in guide 14
system

event log, viewing 43
System Information utility 140
system logs 54

T
tape drive

driver, installing 215
TCP/IP

diagnostics 57
testing

POST diagnostics 37
tools 17
tracert command 61
typographic conventions 14

U
uninstalling

what is removed 266
upgrading

CallPilot software on the server 241
utilities

System Information 140
utility

chkdsk 55

V
video mode, configuring for pcANYWHERE32

200i server 224
viewing

general information about components 107

W
warm boot, forcing with Console Redirection 83
Warning messages 14
while you work 19
286 CallPilot



May 2000 Index
Windows NT
configuring (hard disk recovery)

as network server 203
date and time 211
display adapter 211
drivers and devices 199
Etherlink III card settings 206
hard drive, formatting 200
network interface drivers 203
network protocols and services 205
network services 207
network settings 208
Token Ring card settings 206
with the Setup Wizard 201

installing (hard disk recovery)
from CD-ROM 197

attention 196

from LAN
attention 194

logging on to 216
service packs, installing 217
system event log, viewing 43

Windows NT 4.0
chkdsk utility 55, 58, 60, 62, 64, 66, 67
diagnostics 51

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            
Part 5: 200i Server Maintenance and Diagnostics 287



Index Standard 1.0
288 CallPilot



*Nortel Networks, the Nortel Networks logo, the Globemark, How the World Shares Ideas, and 
Unified Networks, BNR, CallPilot, DMS, DMS-100, DMS-250, DMS-MTX, DMS-SCP, DPN, 
Dualmode, Helmsman, IVR, MAP, Meridian, Meridian 1, Meridian Link, Meridian Mail, Norstar, SL-1, 
SL-100, Supernode, Symposium, Telesis, and Unity are trademarks of Nortel Networks. 

ACCENT is a trademark of Accent Software International Ltd.

ACTION REQUEST SYSTEM and AR SYSTEM are trademarks of Remedy Corporation.

AMDEK is a trademark of Amdek Corporation.

ANSI is a trademark of the American National Standards Institute, Inc. 

AT&T is a trademark of American Telephone and Telegraph Corporation.

ATRIA is a trademark of Pure Atria Corporation.

CASEWARE is a trademark of Caseware International, Inc.

CLEARCASE is a trademark of Rational Software Corporation.

CONTINUUS is a trademark of Continuus Software Corporation. 

CRYSTAL REPORTS is a trademark of Seagate Software Inc.

FRAME, FRAMEBUILDER, FRAMEMAKER, and POSTSCRIPT are trademarks of Adobe Systems 
Incorporated.

HELVETICA is a trademark of Eltra Corporation.

HITACHI is a trademark of Hitachi Limited.

LOGITECH is a trademark of Logitech, Inc. 

MACINTOSH and APPLE are trademarks of Apple Computer Inc.

MFA is a trademark of Astec International Ltd.

MICROSOFT, MS-DOS, POWERPOINT, WINDOWS, and WINDOWS NT are trademarks of 
Microsoft Corporation.

NOVELL is a trademark of Novell, Inc.

PCANYWHERE is a trademark of Symantec Corporation.

PROMARK and RHOBOT are trademarks of DMI Promark, Inc.

SONY is a trademark of Sony Corporation.

SYBASE is a trademark of Sybase, Inc.

TIMES is a trademark of Heidelberger Druckmaschinen Aktiengesellschaft.

3COM is a trademark of 3Com Corporation.

UNIX is a trademark of X/Open Company Limited.

WINRUNNER is a trademark of Mercury Interactive Corporation.



CallPilot
Installation and Configuration

Part 5: 200i Server Maintenance and Diagnostics

Toronto Information Products
Nortel Networks
522 University Avenue, 14th Floor
Toronto, Ontario, Canada
M5G 1W7

Copyright © 2000 Nortel Networks, All Rights Reserved

Information is subject to change without notice. Nortel Networks reserves the right to make changes 
in design or components as progress in engineering and manufacturing may warrant.

The process of transmitting data and call messaging between the Meridian 1 and CallPilot is 
proprietary to Nortel Networks. Any other use of the data and the transmission process is a violation 
of the user license unless specifically authorized in writing by Nortel Networks prior to such use. 
Violations of the license by alternative usage of any portion of this process or the related hardware 
constitutes grounds for an immediate termination of the license and Nortel Networks reserves the 
right to seek all allowable remedies for such breach.

The preceding page contains Nortel Networks and third-party trademarks.
 
Publication number: 555-7101-214

Product release: 1.07
Document release: Standard 1.0
Date: May 2000

Printed in the United States of America


	Title Page
	Publication history
	Contents
	About this guide
	Overview
	Introduction
	Who should read this guide
	Assumptions
	Glossary and related documents

	Skills you need
	Purpose
	Nortel Networks product knowledge
	PC experience or knowledge
	Other experience or knowledge

	Symbols and conventions
	Symbols
	Choosing commands for procedures

	Preparing for maintenance activities
	Introduction

	Required tools and safety precautions
	Introduction
	Maintenance tools and materials checklist
	Approved replacement parts
	General safety
	Cooling and airflow

	Avoiding electrostatic discharge
	Introduction
	Antistatic wrist strap
	While you work
	Conductive foam padded in-boards

	Handling cards
	Introduction
	Avoiding electrostatic discharge
	Precautions for handling cards

	Handling hard disks
	Introduction
	Avoid vibration or physical shock
	Precautions for handling hard disks
	Shipping damage
	Precautions when removing hard drives
	Store hard drives


	Diagnosing the server
	Section A: LED and hex displays
	Status LED and hex display location
	Understanding the Status LED
	Introduction
	LED functions
	Server boot sequence indicators
	Server status after installation

	Understanding the hex display
	Introduction
	Hex display functions
	Server boot sequence indicators
	Server status after boot sequence

	Diagnostic codes
	Introduction
	Critical bootup diagnostics
	Noncritical bootup diagnostics
	Noncritical operating system and switch diagnostics

	Section B: Diagnosing server bootup problems
	What to do when the 200i server fails to boot
	To determine why the 200i server failed to boot up

	Power-On Self-Test (POST) diagnostics
	Introduction
	Viewing bootup results
	Successful bootup example
	Successful bootup description
	POST diagnostic failures
	What to do if a POST diagnostic failure occurs

	Viewing event logs
	Introduction
	To use the Windows NT Event Viewer on the 200i server
	Where to get more information

	Section C: Viewing installation and configuration log files
	Viewing installation and configuration log files
	Installation or upgrade event log file
	Configuration Wizard log file

	Section D: Performing Windows NT online diagnostics
	Overview
	Introduction

	Checking hardware using Windows NT 4.0 diagnostics
	Introduction
	Windows NT Diagnostics window
	Windows NT Diagnostics main window
	To access Windows NT 4.0 diagnostic tools
	Event Viewer

	Invoking the chkdsk utility
	Introduction
	Chkdsk utility syntax
	To run the chkdsk utility from Windows NT 4.0

	Invoking and interpreting TCP/IP diagnostics
	Introduction
	The ipconfig command
	To run the ipconfig command from Windows NT 4.0
	The ping command
	To run the ping command from Windows NT 4.0
	The tracert command
	To run the tracert command from Windows NT 4.0
	The arp command
	To run the arp command from Windows NT 4.0
	The nbtstat command
	To run the nbtstat command from Windows NT 4.0
	The netstat command
	To run the netstat command from Windows NT 4.0

	Invoking and interpreting Token Ring card diagnostics
	Introduction
	Using the ping command

	Section E: Working with Console Redirection
	About Console Redirection
	Introduction
	Difference between Console Redirection and pcANYWHERE32
	When to use Console Redirection
	Where Console Redirection can be used
	Restrictions

	Console Redirection requirements
	Introduction
	Direct serial connection requirements
	Modem connection requirements

	Setting up a direct serial connection
	Introduction
	To configure the client PC
	To shut down the 200i server
	To connect the serial cable

	Setting up a modem connection
	Introduction
	To configure the administration client PC
	To shut down the 200i server
	To configure the modem properties on the administration client PC

	Using Console Redirection
	Introduction
	Types of boots
	OA&M tasks


	Using the Administrative PC to diagnose the server
	Overview
	Introduction

	Section A: Detecting, isolating, and fixing hardware problems
	Overview
	Introduction
	Component dependencies

	Detecting hardware problems
	Introduction
	Other indications of a hardware problem

	Viewing events and isolating problems
	Introduction
	Using the Alarm Monitor
	Using the Event Browser
	Using the Maintenance window

	Checking channel status
	Introduction
	To view call channel states
	To view multimedia channels

	Section B: Working with the Maintenance window
	Overview
	Introduction

	Introducing the Maintenance window
	Introduction
	The General tab
	The Maintenance tab
	The Diagnostics tab
	The Replacement tab

	Obtaining general information about components
	Introduction
	Type of technical information
	To view component details

	Viewing component states
	Introduction
	Component states
	Alert icons
	To view the state of a hardware component

	Starting and stopping components
	Introduction
	Components that can be started and stopped
	To start or stop a component in the Maintenance window

	Running integrated diagnostics
	Introduction
	List of components that have diagnostic tests available
	To view available diagnostic tests
	If a diagnostic test fails or cannot be run
	To run a diagnostic test

	Viewing last diagnostic results
	Introduction
	Field replaceable units
	To view the last diagnostics result
	Last diagnostic results

	Obtaining replacement part numbers
	Introduction


	System utilities
	Overview
	Introduction
	Accessing the System Utilities

	Diagnostics
	Introduction
	To access the startup Diagnostic Tool utility
	To enable startup diagnostics
	To disable startup diagnostics

	Pep Maintenance utility
	Introduction
	To access the PEP Maintenance utility
	To view a list of all installed PEPs

	Services Monitor
	Introduction
	To access the Services Monitor
	Using the Services Monitor

	Session Trace
	Introduction
	To access the session trace tool
	To find a session
	Session type information

	System Information
	Introduction
	To access the System Information utility
	To use the System Information utility

	System Monitor
	Introduction
	To access the System Monitor
	User interface


	Hardware maintenance and upgrade
	Overview
	Introduction
	Preparing for server maintenance
	Removing components
	Installing and replacing card devices

	Section A: Preparing for server maintenance
	Shutting down the server
	Introduction
	Equipment required
	To perform a software shutdown

	Removing the server from the switch
	Introduction
	Equipment required
	To remove the server from the switch
	What’s next?

	Replacing the server
	Introduction
	To replace the server
	What’s next?

	Section B: Removing components
	Removing the daughterboard
	Introduction
	Equipment required
	Before you begin
	To remove the daughterboard
	To replace the daughterboard components
	What’s next?

	Replacing the DIMM
	Introduction
	Equipment required
	Before you begin
	To replace the DIMM
	What’s next?

	Replacing motherboard components
	Introduction
	Equipment required
	Before you begin
	To replace the motherboard components
	What’s next?

	Replacing the EIDE hard drive
	Introduction
	Equipment required
	Before you begin
	To remove the EIDE hard drive
	What’s next?

	Replacing the Nortel Networks software feature key
	Introduction
	Equipment required
	Before you begin
	To replace the software feature key

	Section C: Installing and replacing card devices
	About PC cards
	Introduction
	Supported PC cards

	Network interface cards
	Introduction
	To install a network interface card

	Nortel Networks Multimedia Processing Cards
	Introduction
	Correct card insertion
	MPC card slot LEDs
	To add an MPC-8 card
	To replace MPC cards


	Installing the operating system and server software (for recovery purposes)
	Overview
	Introduction
	Windows NT configuration information worksheet
	What this chapter contains
	Hardware requirements
	Configure the server’s system BIOS
	Install and configure MS-DOS
	Prepare to install Windows NT from the LAN or CD-ROM
	Install Windows NT Server 4.0
	Complete the system build
	Install service packs
	Install pcANYWHERE32
	Install CallPilot server software
	Install Performance Enhancement Packages

	Preparing configuration information for Windows NT
	Configuration information

	Configuring the server’s system BIOS
	Introduction
	To set up the system BIOS

	Installing and configuring MS-DOS
	Introduction
	To install MS-DOS

	Preparing drivers required for Windows NT 4.0 installation
	Introduction
	To copy drivers onto the hard drive

	Preparing to install Windows NT from the LAN
	Introduction
	Before you begin
	To install Windows NT from the LAN

	Preparing to install Windows NT from the CD-ROM
	Introduction
	Before you begin
	To install Windows NT from the CD-ROM

	Installing Windows NT Server 4.0
	Introduction
	Before you begin
	To begin installation and confirm drivers and devices
	To format the hard drive
	To configure with the Windows NT Setup Wizard
	To begin configuration of the server for network use
	To configure network interface card drivers
	To add network protocols and services
	To configure the 3Com Etherlink III or 3Com LAN Megahertz card settings
	To configure the TokenLink Velocity card settings
	To configure network services
	To configure the network addresses
	To configure the date and time
	To configure the display adapter
	To finish Windows NT installation

	Completing the system build
	Introduction
	To reenable Console Redirection
	To clean up the MS-DOS partition
	To install the tape drive driver

	Installing service packs
	Introduction
	To log on to Windows NT
	To install the service packs
	What’s next?

	Installing the updated SCSI driver
	To install the updated SCSI driver
	What’s next?

	Installing pcANYWHERE32 on the 200i server
	Introduction
	To install pcANYWHERE32 on the 200i server
	To start pcANYWHERE32 for the first time
	To set the video mode
	pcANYWHERE patch installation
	To set the pcANYWHERE32 service to Automatic
	What’s next?

	Installing CallPilot server software
	Introduction
	Requirements
	To install the CallPilot server software
	What’s next?

	Installing PEPs
	Introduction
	Identifying the PEPs
	Readme files
	To install a PEP package
	To uninstall a PEP package
	What’s next?


	Upgrading CallPilot server software
	Pre-upgrade checklist
	Introduction
	To ensure a dial-up networking session can be established with CallPilot
	To ensure a pcANYWHERE32 session can be established with CallPilot
	Ensure MMFS volume on Disk 1 is less than 90 percent full
	Check if custom prompts have been recorded
	Ensure the Meridian 1 switch has required patches
	Checking system information
	Check for critical PEPs that have been issued since 1.07 was released

	Preparing for the upgrade
	Introduction
	Timing
	Requirements
	Upgrade checklist
	Before you begin

	Upgrading from 1.0 or 1.06 to 1.07
	To upgrade to a newer release
	To run the Configuration Wizard
	To enable the DSP channels
	What’s next


	Expanding CallPilot features
	Expanding features
	Introduction
	Expansions
	To add features


	Uninstalling CallPilot server software
	Uninstalling CallPilot
	Introduction
	What is removed during uninstallation of CallPilot
	Before you begin
	To uninstall CallPilot server software


	Reinstalling CallPilot server software
	Reinstalling the software (hard drive is functioning)
	Introduction
	Requirements
	To reinstall the CallPilot server software

	Reinstalling languages
	Introduction
	Requirements
	To reinstall languages


	Recovering from a hard drive failure or corrupted software
	Overview
	Introduction
	Reinstalling languages
	Recovering from corrupted software (hard drive is functioning)
	Recovering a CallPilot system from a hard drive failure

	Recovering from a hard drive failure
	Introduction
	Requirements


	Index
	Back

